Instructions for Use

AltoStar®
Parvovirus B19 PCR Kit 1.5

09/2020  EN
AltoStar®

Parvovirus B19 PCR Kit 1.5

For use with

CFX96™ Deep Well Dx System (Bio-Rad)
Content

1. About these Instructions for Use ............................................................. 8
2. Intended Use ............................................................................................. 9
3. Kit Content ................................................................................................. 9
4. Storage and Handling ................................................................................ 10
   4.1 Storage .................................................................................................. 10
   4.2 Handling ............................................................................................... 11
   4.2.1 Master A and Master B .................................................................... 12
   4.2.2 QS and NTC ................................................................................... 12
5. Background Information ........................................................................... 12
6. Product Description .................................................................................. 13
   6.1 Master A and Master B ........................................................................ 14
   6.2 Quantification Standards .................................................................... 14
   6.3 No Template Control .......................................................................... 14
   6.4 AltoStar® Workflow ........................................................................... 15
7. Samples .................................................................................................... 15
   7.1 Sample Types ...................................................................................... 15
   7.2 Sample Collection and Handling .......................................................... 16
   7.3 Sample Volume .................................................................................... 16
   7.4 Sample Tubes ..................................................................................... 17
   7.5 Sample Barcodes ................................................................................ 17
8. Material and Devices Required, but not Provided ..................................... 17
9. Warnings, Precautions and Limitations .................................................... 20
10. Procedure ................................................................................................ 22
    10.1 Overview of the AltoStar® Workflow ................................................ 22
10.2 Starting the AltoStar® AM16.................................................................26
10.3 Performing Maintenance .....................................................................27
10.4 Programming an AltoStar® Run ............................................................29
10.4.1 Manual Programming .......................................................................29
10.4.2 Importing from LIMS ........................................................................36
10.5 Creating an AltoStar® Run .................................................................37
10.6 Starting a Purification Run ....................................................................39
10.6.1 Sample Preparation ............................................................................40
10.6.1.1 Plasma .............................................................................................40
10.6.2 Preparing Reagents for a Purification Run ..........................................41
10.6.3 Instrument Loading for a Purification Run ..........................................42
10.7 During the Purification Run ..................................................................53
10.8 End of the Purification Run ....................................................................55
10.9 Purification Run Results ........................................................................58
10.10 Eluate Stability .....................................................................................60
10.10.1 Storage ..............................................................................................60
10.10.2 Sealing of the Eluate Plate .................................................................60
10.10.3 Unsealing of the Eluate Plate ..............................................................62
10.11 Starting a PCR Setup Run .....................................................................62
10.12 Preparing Reagents for a PCR Setup Run .............................................64
10.12.1 Loading the AltoStar® AM16 for a PCR Setup Run .........................65
10.13 During the PCR Setup Run ..................................................................73
10.14 End of the PCR Setup Run ....................................................................74
10.15 PCR Setup Run Results ........................................................................76
10.16 Sealing of the PCR Plate .................................................................78
10.17 PCR Mix Stability ................................................................................79
10.18 Starting a PCR Run ..............................................................................80
10.19 During the PCR Run ............................................................................83
10.20 Assigning Assays to Well Groups .......................................................84
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.21</td>
<td>PCR Data Analysis</td>
<td>87</td>
</tr>
<tr>
<td>10.21.1</td>
<td>Baseline Correction</td>
<td>88</td>
</tr>
<tr>
<td>10.21.2</td>
<td>Exclusion of Irregular PCR Signals</td>
<td>90</td>
</tr>
<tr>
<td>10.21.3</td>
<td>Setting of Thresholds</td>
<td>94</td>
</tr>
<tr>
<td>10.21.4</td>
<td>Exclusion of Wells Containing Invalid Data</td>
<td>97</td>
</tr>
<tr>
<td>10.21.4.1</td>
<td>Validity of a Diagnostic PCR Run (qualitative)</td>
<td>101</td>
</tr>
<tr>
<td>10.21.4.2</td>
<td>Validity of a Diagnostic PCR Run (quantitative)</td>
<td>101</td>
</tr>
<tr>
<td>10.21.4.3</td>
<td>Validity of Results for a Sample</td>
<td>102</td>
</tr>
<tr>
<td>10.21.5</td>
<td>Export of PCR Results for Automated Result Interpretation</td>
<td>103</td>
</tr>
<tr>
<td>10.21.6</td>
<td>Export of PCR Results for Manual Result Interpretation</td>
<td>105</td>
</tr>
<tr>
<td>10.21.6.1</td>
<td>Manual Interpretation of Results</td>
<td>107</td>
</tr>
<tr>
<td>11.</td>
<td>Disposal</td>
<td>110</td>
</tr>
<tr>
<td>12.</td>
<td>Performance Evaluation</td>
<td>111</td>
</tr>
<tr>
<td>12.1</td>
<td>Plasma</td>
<td>111</td>
</tr>
<tr>
<td>12.1.1</td>
<td>Analytical Sensitivity</td>
<td>111</td>
</tr>
<tr>
<td>12.1.2</td>
<td>Analytical Specificity</td>
<td>112</td>
</tr>
<tr>
<td>12.1.2.1</td>
<td>Negative Samples</td>
<td>113</td>
</tr>
<tr>
<td>12.1.2.2</td>
<td>Interfering Substances</td>
<td>113</td>
</tr>
<tr>
<td>12.1.2.3</td>
<td>Cross Reactivity</td>
<td>113</td>
</tr>
<tr>
<td>12.1.3</td>
<td>Linear Range</td>
<td>114</td>
</tr>
<tr>
<td>12.1.4</td>
<td>Precision</td>
<td>115</td>
</tr>
<tr>
<td>12.1.5</td>
<td>Total Failure Rate</td>
<td>116</td>
</tr>
<tr>
<td>12.1.6</td>
<td>Carry Over</td>
<td>116</td>
</tr>
<tr>
<td>12.1.7</td>
<td>Diagnostic Evaluation</td>
<td>117</td>
</tr>
<tr>
<td>13.</td>
<td>Quality Control</td>
<td>119</td>
</tr>
<tr>
<td>14.</td>
<td>Technical Assistance</td>
<td>119</td>
</tr>
<tr>
<td>15.</td>
<td>Literature</td>
<td>119</td>
</tr>
</tbody>
</table>
16. Trademarks and Disclaimers ................................................................. 120
17. Explanation of Symbols ........................................................................ 121
1. About these Instructions for Use

These Instructions for Use guide the user in utilizing the AltoStar® Parvovirus B19 PCR Kit 1.5 on the AltoStar® Automation System AM16 (Hamilton; in the following summarized as AltoStar® AM16) with the AltoStar® Connect software (Version 1.6.16 or higher, Hamilton) for automated PCR setup and on the CFX96™ Deep Well Dx System* (Bio-Rad, in the following summarized as CFX96™ DW Dx) with the CFX Manager™ Dx software (Version 3.1, Bio-Rad) for real-time PCR. The main operation steps of the complete "AltoStar® Workflow" (for details see chapter 6.4 AltoStar® Workflow) are described for comprehensibility but without any claim for completeness.

For more detailed information about these products please refer to the respective manuals or instructions for use:

- AltoStar® AM16 Operator's Manual IVD (Hamilton)
- AltoStar® Connect Software Manual IVD (Hamilton)
- Instructions for Use AltoStar® Purification Kit 1.5
- Instructions for Use AltoStar® Internal Control 1.5
- CFX96™ Dx and CFX96™ Deep Well Dx Systems Operation Manual (Bio-Rad)

Throughout this manual, the terms CAUTION and NOTE have the following meanings:

**CAUTION**

![Exclamation mark]

Highlights operating instructions or procedures which, if not followed correctly, may result in personal injury or impact product performance. Contact altona Diagnostics Technical Support for assistance.

**NOTE**

Information is given to the user that is useful but not essential to the task at hand.

Read the Instructions for Use carefully before using the product.

* “CFX96™ Deep Well Dx System” is the new brand name for the IVD version of the CFX96™ Deep Well Real-Time PCR Detection System (Bio-Rad).
2. Intended Use

The AltoStar® Parvovirus B19 PCR Kit 1.5 is an *in vitro* diagnostic test, based on real-time PCR technology, for the detection and quantification of Parvovirus B19 specific DNA in human plasma.

The AltoStar® Parvovirus B19 PCR Kit 1.5 is configured for use with the CFX96™ Deep Well Dx System (Bio-Rad) in combination with the AltoStar® Automation System AM16, the AltoStar® Purification Kit 1.5 and the AltoStar® Internal Control 1.5. The results generated with the AltoStar® Parvovirus B19 PCR Kit 1.5 have to be interpreted in conjunction with other clinical and laboratory findings.

The AltoStar® Parvovirus B19 PCR Kit 1.5 is intended for use by professional users trained in molecular biological techniques.

3. Kit Content

The AltoStar® Parvovirus B19 PCR Kit 1.5 contains the following components:

**Table 1: Kit Components**

<table>
<thead>
<tr>
<th>Lid Color</th>
<th>AltoStar® Parvovirus B19 1.5 Component</th>
<th>Number of Tubes</th>
<th>Nominal Volume [µl/Tube]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Master A</td>
<td>8</td>
<td>60</td>
</tr>
<tr>
<td>Purple</td>
<td>Master B</td>
<td>8</td>
<td>180</td>
</tr>
<tr>
<td>Red</td>
<td>QS1*</td>
<td>2</td>
<td>250</td>
</tr>
<tr>
<td>Red</td>
<td>QS2*</td>
<td>2</td>
<td>250</td>
</tr>
<tr>
<td>Red</td>
<td>QS3*</td>
<td>2</td>
<td>250</td>
</tr>
<tr>
<td>Red</td>
<td>QS4*</td>
<td>2</td>
<td>250</td>
</tr>
<tr>
<td>White</td>
<td>NTC**</td>
<td>2</td>
<td>250</td>
</tr>
</tbody>
</table>

* Quantification Standard
** No Template Control
The AltoStar® Parvovirus B19 PCR Kit 1.5 contains enough reagents to perform 96 reactions in a maximum number of 8 runs.

The product is shipped on dry ice. Upon receipt and before first use please check the product and its components for:

- Integrity
- Completeness with respect to number, type and filling
- Correct labelling
- Expiration date
- Frozen state
- Clarity and absence of particles

If one or more product components are not frozen upon receipt, if tubes have been compromised during shipment or are missing, contact altona Diagnostics Technical Support for assistance (see chapter 14 Technical Assistance).

### 4. Storage and Handling

All reagents included in the AltoStar® Parvovirus B19 PCR Kit 1.5 are ready-to-use solutions.

#### 4.1 Storage

All components of the AltoStar® Parvovirus B19 PCR Kit 1.5 must be stored between -25 °C and -15 °C upon arrival.
CAUTION

Improper storage conditions may lead to a compromised product performance.

CAUTION

Do not use product components beyond the expiration date printed on the component label.

4.2 Handling

CAUTION

Do not exceed thaw-freeze-sequence and handling durations as specified in these Instructions for Use.

CAUTION

Improper handling of product components and samples may lead to contamination causing incorrect IVD examination results.

- Do not interchange vial or bottle caps, as cross-contamination may occur.
- To minimize the risk of carryover contamination store positive and/or potentially positive material separated from the kit components.
- Use separated working areas for sample preparation/reaction setup and amplification/detection activities.
- Always wear disposable gloves.
- Do not open the PCR plates post amplification to avoid contamination with amplicons.

NOTE

Only components of the same kit lot are compatible.
4.2.1 Master A and Master B

After thawing, Master A and Master B are stable for 5 hours at up to +30 °C.

**NOTE**

If Master A and Master B were thawed but not used, they can be refrozen and thawed again once for later runs. If opened, discard the lids and use new lids to avoid contamination of the reagents.

4.2.2 QS and NTC

1. After thawing, the QS and the NTC are stable for 5 hours at up to +30 °C.
2. Discard the lids of the QS and NTC tubes at each use and use new lids to avoid contamination of the reagents.
3. After use close the QS and NTC tubes with new lids and freeze them immediately.
4. Do not exceed the following thaw-freeze-sequence for each QS and NTC tube: Thaw 1 → Freeze 1 → Thaw 2 → Freeze 2 → Thaw 3 → Freeze 3 → Thaw 4

5. Background Information

Human parvovirus B19 (parvovirus B19), also called erythrovirus B19, was the first known human virus in the family of *Parvoviridae* and the genus *Erythroparvovirus*. The virus is a non-enveloped, icosahedral virus that contains a single-stranded linear DNA genome.

Parvovirus B19 causes a childhood rash called fifth disease or erythema infectiosum which is commonly called slapped cheek syndrome. Parvovirus B19 is a major cause of aplastic crisis in patients with hemolytic anemia. Severe fetal complications can be observed, especially following maternal infections during the second and third trimesters.
Three distinct genotypes (Genotype I-III) of human parvovirus B19 have been identified, varying by up to 15% in nucleotide identity. Based upon sequence analysis and biological properties, the International Committee on Taxonomy of Viruses has classified representatives of the three genotypes as species of human parvovirus B19. In Europe, regulatory requirements specify that plasma pools used in the production of anti-D immunoglobulin and plasma treated for virus inactivation are tested for levels of parvovirus B19 DNA. Such plasma pools must not exceed a threshold concentration of 10 IU/μl for parvovirus B19 DNA, as defined by the WHO IS.

6. Product Description

The AltoStar® Parvovirus B19 PCR Kit 1.5 is an in vitro diagnostic test for the detection and quantification of parvovirus B19 specific DNA in human plasma within the AltoStar® Workflow (for details see chapter 6.4 AltoStar® Workflow). It is based on real-time PCR technology, utilizing polymerase chain reaction (PCR) for the amplification of parvovirus B19 specific target sequences and fluorescently labelled target specific probes for the detection of the amplified DNA.

In addition to the parvovirus B19 DNA specific amplification and detection system the assay includes oligonucleotides for the amplification and detection of the IC (AltoStar® Internal Control 1.5). The IC is automatically added at the beginning of the nucleic acid purification procedure on the AltoStar® AM16. For details refer to the Instructions for Use of the AltoStar® Internal Control 1.5.

Probes specific for parvovirus B19 DNA are labelled with the fluorophore FAM™. The probe specific for the IC is labelled with a fluorophore detectable in the VIC™ channel.

Using probes linked to distinguishable dyes enables the parallel detection of parvovirus B19 specific DNA and the Internal Control in corresponding detector channels of the CFX96™ DW Dx.
6.1 Master A and Master B
Master A and Master B contain all components (PCR buffer, DNA polymerase, magnesium salt, primers and probes) to allow the PCR mediated amplification and target detection of parvovirus B19 specific DNA and of the IC (AltoStar® Internal Control 1.5) in one reaction setup.

6.2 Quantification Standards
The Quantification Standards (QS) contain standardized concentrations of parvovirus B19 specific DNA (see Table 2). They were calibrated against the 3rd WHO International Standard for Parvovirus B19 for Nucleic Acid Amplification Techniques (NIBSC code: 12/208). The Quantification Standards are used to verify the functionality of the parvovirus B19 DNA specific amplification and detection system as well as to generate a standard curve, which allows the quantification of parvovirus B19 specific DNA in a sample.

Table 2: Quantification Standards

<table>
<thead>
<tr>
<th>Quantification Standard</th>
<th>Concentration [IU/µl]</th>
</tr>
</thead>
<tbody>
<tr>
<td>QS1</td>
<td>1.00E+04</td>
</tr>
<tr>
<td>QS2</td>
<td>1.00E+03</td>
</tr>
<tr>
<td>QS3</td>
<td>1.00E+02</td>
</tr>
<tr>
<td>QS4</td>
<td>1.00E+01</td>
</tr>
</tbody>
</table>

6.3 No Template Control
The No Template Control (NTC) contains no parvovirus B19 specific DNA but does contain the Internal Control template. The NTC is used as negative control for the parvovirus B19 DNA specific real-time PCR and indicates possible contamination of Master A and Master B.
6.4 AltoStar® Workflow

The AltoStar® Parvovirus B19 PCR Kit 1.5 is intended for use within the AltoStar® Workflow. The AltoStar® Workflow includes the following steps:

2. Purification Run on the AltoStar® AM16 using the AltoStar® Purification Kit 1.5 and the AltoStar® Internal Control 1.5.
3. PCR Setup Run on the AltoStar® AM16 using the AltoStar® Parvovirus B19 PCR Kit 1.5.
4. Real-time PCR Run on a CFX96™ DW Dx.

All sample types and sample volumes specified for use with the AltoStar® Purification Kit 1.5 can be processed simultaneously on the AltoStar® AM16. Each sample can be analyzed with as many assays in parallel as the available eluate allows.

**NOTE**

Assays with differing PCR temperature profiles are automatically sorted to separate PCR Plates.

7. Samples

7.1 Sample Types

The following sample types are validated for use with the AltoStar® Parvovirus B19 PCR Kit 1.5:

- Human EDTA plasma
- Human citrate plasma

**CAUTION**

Do not use other sample types! The use of other sample types may compromise the product performance.
7.2 Sample Collection and Handling
Blood has to be collected with commercially available standard blood collection systems (e.g. Sarstedt, Becton Dickinson, Greiner or equivalent). Tube contents should be mixed directly after sample collection. The blood samples should be shipped cooled (2 °C - 8 °C). Transport should occur following the local and national instructions for the transport of biological material.

For generation of EDTA plasma, whole blood should be centrifuged according to the instructions provided by the manufacturer of the collection system within 24 hours after collection. EDTA plasma should be stored at 2 °C - 8 °C for no longer than 14 days (Abdul-Ali et al. 2011).

**CAUTION**
Always treat samples as infectious and (bio-)hazardous in accordance with safe laboratory procedures. For sample material spills promptly use an appropriate disinfectant. Handle contaminated materials as biohazardous.

**NOTE**
Frozen storage of samples does not compromise kit performance. When working with frozen samples, make sure samples are completely thawed and properly mixed before use.

7.3 Sample Volume
The AltoStar® Parvovirus B19 PCR Kit 1.5 is validated for nucleic acid purifications from a sample volume of 500 μl. Additional sample volume has to be provided to account for the dead volume of the sample tube used (see chapter 7.4 Sample Tubes).
7.4 Sample Tubes
Sample tubes suitable for use on the AltoStar® AM16 can be purchased from altona Diagnostics (7 ml tube with cap, 82 x 13 mm, VK000010). Other sample tubes can be tested for applicability by the user. For details refer to the Instructions for Use of the AltoStar® Purification Kit 1.5.

7.5 Sample Barcodes
For automated sample identification by the AltoStar® AM16 all sample tubes must be labelled with a suitable barcode. For details refer to the Instructions for Use of the AltoStar® Purification Kit 1.5.

8. Material and Devices Required, but not Provided
The material and devices shown in Table 3 must be ordered from altona Diagnostics GmbH.

Table 3: Required material and devices

<table>
<thead>
<tr>
<th>Material Name</th>
<th>Description</th>
<th>Order No.</th>
<th>Shipping Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>AltoStar® AM16</td>
<td>AltoStar® Automation System AM16</td>
<td>806160</td>
<td>1</td>
</tr>
<tr>
<td>AltoStar® Connect software</td>
<td>AltoStar® Connect software (Version 1.6.16 or higher)</td>
<td>911275</td>
<td>1</td>
</tr>
<tr>
<td>CFX96™ DW Dx</td>
<td>CFX96™ Deep Well Dx System* (Bio-Rad) with CFX Manager™ Dx software (Version 3.1)</td>
<td>DT16</td>
<td>1</td>
</tr>
<tr>
<td>AltoStar® Purification Kit 1.5</td>
<td>AltoStar® Purification Kit 1.5</td>
<td>PK15-16</td>
<td>1</td>
</tr>
<tr>
<td>AltoStar® Internal Control 1.5</td>
<td>AltoStar® Internal Control 1.5</td>
<td>IC15-16</td>
<td>1</td>
</tr>
<tr>
<td>PCR Plate</td>
<td>Hard-Shell® PCR Plate 96-Well, Low-Profile, Semi-Skirted, Clear shell, White well - barcoded</td>
<td>VK000005</td>
<td>25</td>
</tr>
<tr>
<td>Material Name</td>
<td>Description</td>
<td>Order No.</td>
<td>Shipping Unit</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>---------------</td>
</tr>
<tr>
<td>AltoStar® PCR Plate Sealing Foil</td>
<td>AltoStar® PCR Plate Sealing Foil with cut corner A1 and 10 mm sides (SP-0235)</td>
<td>VK000006</td>
<td>100</td>
</tr>
<tr>
<td>1000 μl CO-RE Tips</td>
<td>CO-RE Tips, 8 x 480 High Volume Tips (1000 μl) with Filters</td>
<td>VK000007</td>
<td>3840</td>
</tr>
<tr>
<td>300 μl CO-RE Tips</td>
<td>CO-RE Tips, 12 x 480 Standard Volume Tips (300 μl) with Filters</td>
<td>VK000008</td>
<td>5760</td>
</tr>
<tr>
<td>Pooling Tube</td>
<td>Tube 5 ml, 92 x 15.3 mm (round), PP, with barcode</td>
<td>VK000002</td>
<td>1000</td>
</tr>
<tr>
<td>Waste Bag</td>
<td>Sterilbag, Bag Type 60 - Autoclave 134 °C</td>
<td>VK000009</td>
<td>500</td>
</tr>
<tr>
<td>Screw Cap - red (cap for QS1 - QS4)</td>
<td>Screw cap for micro tubes, red</td>
<td>VK000012</td>
<td>5000</td>
</tr>
<tr>
<td>Screw Cap - blue (cap for Master A)</td>
<td>Screw cap for micro tubes, blue</td>
<td>VK000013</td>
<td>5000</td>
</tr>
<tr>
<td>Screw Cap - purple (cap for Master B)</td>
<td>Screw cap for micro tubes, purple</td>
<td>VK000015</td>
<td>5000</td>
</tr>
<tr>
<td>Screw Cap - white (cap for NTC)</td>
<td>Screw cap for micro tubes, white</td>
<td>VK000016</td>
<td>5000</td>
</tr>
</tbody>
</table>

* “CFX96™ Deep Well Dx System” is the new brand name for the IVD version of the CFX96™ Deep Well Real-Time PCR Detection System (Bio-Rad).
NOTE

Do not use other materials or devices than specified in these Instructions for Use.

Table 4: Additional laboratory material and devices

<table>
<thead>
<tr>
<th>Material</th>
<th>Description</th>
<th>Order No.</th>
<th>Shipping Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Sealer</td>
<td>e.g. AltoStar® Plate Sealer</td>
<td>VK000023</td>
<td>1</td>
</tr>
</tbody>
</table>

General material and devices:

- Vortex mixer
- Powder-free gloves (disposable)
- Centrifuge for centrifugation of PCR kit reagents
- Centrifuge for centrifugation of PCR plates
9. Warnings, Precautions and Limitations

- Before first use check the product and its components for completeness with respect to number, type and filling. Do not use a defective or incomplete product, performance could be compromised.

- Do not use other sample types! The use of other sample types may compromise the product performance.

- The presence of PCR inhibitors (e.g. heparin) may cause false negative or invalid results.

- In case the sample contains other pathogens than parvovirus B19 competition with the target amplification or cross-reactivities may occur.

- Improper storage conditions may lead to a compromised product performance.

- A lack of centrifugation of the product components after thawing could lead to contamination of the components with reagent residues in the lids and as consequence to a compromised product performance.

- Do not exceed thaw-freeze-sequence and handling durations as specified in these Instructions for Use.

- Do not reuse tube caps to avoid contamination of the reagents.

- Do not use product components beyond the expiration date printed on the component label.

- Improper handling of product components and samples may lead to contamination causing incorrect IVD examination results.
  - Do not interchange vial or bottle caps, as cross-contamination may occur.
  - To minimize the risk of carryover contamination store positive and/or potentially positive material separated from the kit components.
  - Use separated working areas for sample preparation/reaction setup and amplification/detection activities.
  - Always wear disposable gloves.
  - Do not open the PCR Plates post amplification to avoid contamination with amplicons.

- Storage of eluates under wrong conditions may lead to degradation of the parvovirus B19 target sequence.

- Do not exceed the PCR Mix storage time. This could lead to a compromised product performance.
• Always treat samples as infectious and (bio-)hazardous in accordance with safe laboratory procedures. For sample material spills promptly use an appropriate disinfectant. Handle contaminated materials as biohazardous.

• Dispose of hazardous and biological waste only in compliance with local and national regulations to avoid environmental contamination.

• As with any diagnostic test, results should be interpreted in consideration of all clinical and laboratory findings.

• Potential mutations within the target regions of the parvovirus B19 genome covered by the primers and/or probes used in the kit may result in failure to detect the presence of the pathogen.
10. Procedure

10.1 Overview of the AltoStar® Workflow

The steps of the AltoStar® Workflow are summarized in Table 5.

Table 5: Overview of the AltoStar® Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1. Start the AltoStar® AM16 | • Switch on the AltoStar® AM16.  
• Switch on the computer and the monitor.  
• Start the AltoStar® Connect software. |
| 2. Perform Maintenance | In the menu bar click Application → Instrument Maintenance.  
• If Weekly Maintenance is due, click Start Weekly Maintenance.  
• If Daily Maintenance is due, click Start Daily Maintenance.  
Follow the on screen instructions for the maintenance process. |
| 3. Program an AltoStar® Run | In the menu bar click Program Run → Program Run (AltoStar® Purification). Alternatively, go back to the Start Screen and click the Program Run button.  
• Enter samples or import from LIMS,  
• Select assays for the samples unless already imported from LIMS,  
• Click the Create Run button in the tool bar to create the AltoStar® Run. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| **4. Start a Purification Run** | In the menu bar click **Purification → Start Purification**. Alternatively, go back to the Start Screen and click the **Start Purification** button.  
• Select the Purification Run to be started to display the samples included in the selected Purification Run.  
• Prepare the purification reagents:  
  ◦ Ensure that the purification reagents to be used have the same **Loading Number** (except AltoStar® Internal Control 1.5) and are not expired.  
  ◦ If precipitates are visible in the Lysis Buffer, heat it (≤ 50 °C) until completely dissolved.  
  ◦ Thaw the IC (AltoStar® Internal Control 1.5) and vortex for 5 seconds.  
  ◦ Vortex the Magnetic Beads for 5 seconds without wetting the lid.  
• Prepare the samples for the Purification Run to be started as described in chapter 10.6.1 Sample Preparation.  
• Click the **Start Run** button in the tool bar.  
• Follow the loading dialogs and load the instrument accordingly.  
• Confirm the **Loading complete** message with **Ok** or wait ten seconds.  
The system will now perform the Purification Run automatically. |
| **5. Finish the Purification Run** | • Make sure the Loading Tray is empty and confirm the **Run finished** dialog with **Ok**.  
• Follow the instructions in the **Maintenance** dialog and confirm with **Ok**.  
• Seal and store the components of the AltoStar® Purification Kit 1.5 that can be reused.  
• If the associated PCR Setup Run is not started right away, seal the Eluate Plate with the AltoStar® Eluate Plate Sealing Foil and store at 2 °C - 8 °C for up to 24 hours.  
• View the Purification Run results to confirm successful processing of each sample. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. Start a PCR Setup Run</td>
<td>In the menu bar, click <strong>PCR Setup → Start PCR Setup</strong>. Alternatively, go back to the Start Screen and click the <strong>Start PCR Setup</strong> button.</td>
</tr>
<tr>
<td></td>
<td>• Select the PCR Setup Run to be started in order to display the Eluate Plate and reagents included in the selected PCR Setup Run.</td>
</tr>
<tr>
<td></td>
<td>• Prepare the PCR reagents:</td>
</tr>
<tr>
<td></td>
<td>◦ Ensure that Masters and Controls to be used are from the same kit lot and are not expired.</td>
</tr>
<tr>
<td></td>
<td>◦ Thaw the required amount of Master and Control tubes, vortex briefly and spin down in a centrifuge.</td>
</tr>
<tr>
<td></td>
<td>• If the Eluate Plate is sealed, briefly centrifuge the plate and unseal carefully.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Start Run</strong> button in the tool bar.</td>
</tr>
<tr>
<td></td>
<td>• Follow the <strong>Loading</strong> dialog and load the instrument accordingly.</td>
</tr>
<tr>
<td></td>
<td>• Confirm the <strong>Loading complete</strong> message with <strong>Ok</strong> or wait 10 seconds.</td>
</tr>
<tr>
<td></td>
<td>• The system will now perform the PCR Setup Run automatically.</td>
</tr>
<tr>
<td>7. Finish the PCR Setup Run</td>
<td>Make sure the Loading Tray is empty and confirm the <strong>Run finished</strong> dialog with <strong>Ok</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Follow the instructions in the <strong>Maintenance</strong> dialog and confirm with <strong>Ok</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Close and store the components of the AltoStar® Parvovirus B19 PCR Kit 1.5 that can be reused.</td>
</tr>
<tr>
<td></td>
<td>• View the PCR Setup Run results to confirm successful processing of each sample.</td>
</tr>
<tr>
<td>8. Seal the PCR Plate</td>
<td>• Seal the PCR Plate with the AltoStar® PCR Plate Sealing Foil.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 9. Start the PCR Run                      | • Switch on the CFX96™ DW Dx, the attached computer and the monitor.  
• Start the CFX Manager™ Dx software.  
• Open the CFX96™ DW Dx.  
• Centrifuge the PCR Plate and insert it into the CFX96™ DW Dx.  
• Select **File → Open → LIMS File...** from the menu bar.  
• Scan the barcode of the PCR Plate with the handheld barcode scanner.  
• Close the CFX96™ DW Dx.  
• Click the **Start Run** button to start the PCR Run. Name and save the PCR run file.  
• The CFX96™ DW Dx will now perform the PCR Run automatically. |
| 10. Separate assays for individual analysis| • Separate all assays in the PCR Run into distinct Well Groups                                                                                                                                               |
| 11. Analyse the data and interpret the PCR Run results | For each Well Group individually:  
• Perform baseline correction in all wells for all detection channels used.  
• Exclude wells with irregular PCR signals.  
• Set the thresholds of all detection channels according to the controls.  
• Exclude wells containing invalid data.  
• Generate the LIMS Result File for export of results to the LIMS.  
• Generate the result report for manual result interpretation. |
10.2 Starting the AltoStar® AM16

1. Turn on the AltoStar® AM16 with the front left green switch and start the computer by pressing the power button.

2. Wait until Windows has booted.

3. Start the AltoStar® Connect software using the icon on the Windows desktop, the Windows task bar or in the Windows start menu.

The Start Screen of the AltoStar® Connect software is displayed (see Figure 1) showing three buttons representing the AltoStar® Workflow steps to be performed on the AltoStar® AM16:

- **Program Run**: Sample data are entered and assays are assigned to the samples. The programmed samples are then assigned to an AltoStar® Run (see chapter 10.5 Creating an AltoStar® Run), which includes one Purification Run and one or more PCR Setup and PCR runs. Several AltoStar® Runs can be preprogrammed in advance.

- **Start Purification**: A programmed Purification Run is selected and started as described in chapter 10.6 Starting a Purification Run.

- **Start PCR Setup**: A programmed PCR Setup Run is selected and started as described in chapter 10.11 Starting a PCR Setup Run.
10.3 Performing Maintenance

1. Access the Maintenance Screen by clicking Application → Instrument Maintenance in the menu bar (see Figure 1).

A valid status of the Daily Maintenance and Weekly Maintenance is depicted by a green check mark in the column Status (see Figure 2). If a red crossed circle is displayed, the respective maintenance procedure has to be performed.

If the Daily or Weekly Maintenance has to be performed:

1. Click the corresponding button in the tool bar.
2. Follow the on screen instructions to complete the maintenance procedure. Refer to the AltoStar® Automation System AM16 Operator’s Manual IVD and the AltoStar® Connect Software Manual IVD for detailed information.

The maintenance routines verify the correct functionality of the instrument and will prompt all necessary user actions including cleaning of the instrument.

**NOTE**

*Verification* refers to the semi-annual maintenance procedure that is performed by Hamilton trained field service engineers. The *Verification* row must show a green check mark in the column *Status* as well. Otherwise the instrument will not process any samples or reagents.

---

**Figure 2:** Maintenance Screen with valid maintenance status
10.4 Programming an AltoStar® Run

Input of sample data and assay assignments can be done manually (see chapter 10.4.1 Manual Programming) or by import from a connected Laboratory Information Management System (LIMS). If no manual programming is necessary, continue with chapter 10.4.2 Importing from LIMS.

10.4.1 Manual Programming

1. Click Program Run → Program Run (AltoStar® Purification) in the menu bar. Alternatively, go back to the Start Screen of the AltoStar® Connect software and select the Program Run button.

The Programming Screen is displayed (see Figure 3) showing the sample table at the bottom of the screen with columns for:

- Sample properties: Sample Name (optional), Sample Barcode, Sample Type and Predilution
- Sample settings: Process Sample, Sample Priority
- Sample information: required Sample Volume for the Purification Run (dead volume not factored in), Eluate left (determined by assay assignment)
- Assay assignment to the samples: Programming

NOTE

The sample settings Process Sample and Sample Priority are selected manually while the sample information Sample Volume and Eluate left are set automatically when assigning PCR assays to the samples.
2. Click the **Add Samples** button to manually add samples to the sample table. The **Add Samples** dialog will appear (see Figure 4).
3. Select the sample type Plasma in the Sample Type field.

**NOTE**

If the wrong sample type is selected in the Sample Type field the sample may not be processed.

4. *Optional:* Enter a sample name in the Sample Name field.

5. Enter a barcode via the handheld barcode scanner in the Sample Barcode field. A unique barcode for each sample tube is required.

6. Check for each sample if the required sample volume of 500 μl plus dead volume of the sample tube used is available.
NOTE

Insufficient sample volume (e.g. due to lack of the required dead volume of the sample tube) will lead to the exclusion of the sample in the Purification Run.

7. Tick the **Predilution** checkbox if the sample needs to be prediluted during the sample preparation procedure (see chapter 10.6.1 Sample Preparation) to provide the required sample volume.

   - The **Sample Volume** field and **Added Diluent** field will appear (see Figure 5), each with 1000 μl as preset volumes.
   - Change the preset volumes of 1000 μl in the **Sample Volume** field and **Added Diluent** field to match the volumes that will be used during the sample preparation.
Figure 5: Add Samples dialog: Ticket Predilution checkbox

NOTE
The predilution will be included in the Concentration Factor, which is reported in the PCR results to calculate the target concentration in the original sample from the PCR results (see chapter 10.21.6.1 Manual Interpretation of Results). The calculation is either done by the user or by the LIMS during import of the PCR results.

NOTE
The predilution property of a sample can be edited after closing the Add Samples dialog by ticking the checkbox in the column Predilution of the sample table.

8. Click the Add button to add the sample to the sample table.
9. Repeat the steps above until all samples are added to the sample table.
10. When all samples are added, click the Close button to close the Add Samples dialog. The added samples are displayed in the sample table of the Programming Screen (see Figure 6).

```
Figure 6: Programming Screen with added samples
```

**NOTE**

The sample list can be sorted by individual columns by clicking the column header. Multiple samples can be selected by holding down the Shift-Key or Ctrl-Key while clicking on sample lines. The selected samples can be modified collectively by clicking the wrench symbol in the appropriate column header. Samples can be removed from the list by selecting them and clicking the Delete button in the tool bar.

11. Assign the AltoStar® Parvovirus B19 PCR Kit 1.5 assay to specific samples by clicking in the cell which is in the row of the respective sample and in the column of the AltoStar® Parvovirus B19 PCR Kit 1.5 (see Figure 7).

12. Select quantitative or qualitative in the appearing menu.
Figure 7: Programming Screen: PCR Assay Assignment

The correct set of Standards and Controls is automatically selected for qualitative and quantitative assay application. Additionally, the required sample volume for the Purification Run (dead volume not factored in) and the eluate volume that remains available for assignment to other assays are automatically adjusted in the sample list columns Sample Volume and Eluate left, respectively.

NOTE

AltoStar® Parvovirus B19 PCR Kit 1.5 settings:

- For quantitative assay application QS1-4 and NTC are selected and for qualitative assay application QS4 and NTC are selected.

- The required sample volume is 500 μl plus the dead volume for the respective sample tube (see chapter 7.3 Sample Volume).

- The required eluate volume for the AltoStar® Parvovirus B19 PCR Kit 1.5 is 10 μl.
10.4.2 Importing from LIMS

Both the sample properties as well as the assay assignment can be imported from the LIMS. To do so, click the Import File button in the tool bar. In the dialog that opens, select the Import File (.psv) that contains the required information.

For information regarding the LIMS integration, contact altona Diagnostics Technical Support (see chapter 14 Technical Assistance).
10.5 Creating an AltoStar® Run

For processing the samples in the sample table must be assigned to an AltoStar® Run which includes the Purification Run as well as one or more PCR Setup Runs and PCR Runs for a given sample.

1. Tick the Sample Priority checkbox for samples that should be sorted to the same PCR Plate for fastest processing.
   - Initially, all samples are ticked in the column Process Sample indicating that the respective samples are to be included in the AltoStar® Run generated next.
   - Above the sample table in the Programming Screen (see Figure 7), Wells used is displayed (showing the number of the AltoStar® Processing Plate wells needed for processing of the samples currently ticked in the column Process Sample).
   - Up to 96 wells can be used in one Purification Run.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AltoStar® Processing Plate is a consumable for Purification Runs and contains 96 wells that can be used for processing of samples. Samples with a processing volume of 1000 μl need two wells of the AltoStar® Processing Plate. Thus, the maximum number of samples that can be processed in one Purification Run varies and depends on the number of samples with a processing volume of 1000 μl.</td>
</tr>
</tbody>
</table>

- If the number of 96 wells is exceeded, the AltoStar® Run cannot be created and Wells used is displayed in red.

2. In this case, deselect samples in the column Process Sample until Wells used displays 96 or less. The remaining samples still ticked in the column Process Sample will be assigned to the next AltoStar® Run.

3. Click the Create Run button in the tool bar of the Programming Screen. The Save Run Definition dialog is displayed (see Figure 8).
NOTE

No further modifications to samples are possible after clicking the **Create Run** button. If changes to a created AltoStar® Run are necessary, the created AltoStar® Run has to be deleted and manual programming or the import from LIMS has to be repeated.

4. Enter a unique **Run Name** and optionally a **Description** for identification of the AltoStar® Run later on.

5. Click the **Ok** button to save the AltoStar® Run.

![Save Run Definition dialog](image)

**Figure 8:** Save Run Definition dialog

Samples that have been assigned to an AltoStar® Run are removed from the sample table of the Programming Screen. To create further AltoStar® Runs for the remaining samples in the sample table:

6. Select up to 96 of the remaining samples in the column **Process Sample**.

7. Click the **Create Run** button and repeat the steps 4 and 5.
10.6 Starting a Purification Run

1. Select **Purification → Start Purification** in the menu bar. Alternatively, go back to the Start Screen of the AltoStar® Connect software and select the **Start Purification** button.

   - The Start Purification Run Screen is displayed (see Figure 9). Each programmed AltoStar® Run includes one Purification Run.
   - The pending Purification Runs are displayed in the **Programmed Purification Runs** table on the left side of the screen.

   ![](image)

   **Figure 9**: Start Purification Run Screen

2. Select the Purification Run to be started in the **Programmed Purification Runs** table. The samples included in the selected Purification Run are displayed in the table on the right side of the screen (**Samples in selected Purification Run**).

   Before clicking the **Start Run** button in the tool bar, prepare the samples of the selected Purification Run and the reagents as described in chapters 10.6.1 Sample Preparation and 10.6.2 Preparing Reagents for a Purification Run.
10.6.1 Sample Preparation

For correct results the specifications regarding sample type, sample collection, sample volume, sample tube and sample barcode (see chapter 7 Samples) as well as with respect to sample preparation have to be followed carefully.

1. Prepare all samples that shall be used in the next Purification Run. The samples required for the selected Purification Run are listed in the table (Samples in selected Purification Run) on the right side of the Start Purification Run screen.

2. Provide at least 500 µl sample volume plus the required dead volume in a suitable sample tube.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The samples must be free of solids and high-viscosity constituents. Solids and high-viscosity constituents will interfere with the sample transfer on the AltoStar® AM16 and the samples will not be processed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sample volume is not checked by the system prior to processing. Samples with insufficient volume will not be processed and error flagged during the sample transfer step.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the samples must be prediluted: Predilution diluent, which is not compatible with this application may affect nucleic acid stability, sample transfer and purification performance.</td>
</tr>
</tbody>
</table>

10.6.1.1 Plasma

Plasma samples that are free of solids and high-viscosity constituents can be processed without pretreatment on the AltoStar® AM16.
10.6.2 Preparing Reagents for a Purification Run

1. Ensure to prepare sufficient amounts of non-expired reagents which all have to have the same Loading Number.

The Loading Number consists of the last four lot number digits of the Lysis Buffer and Wash Buffer containers and the Magnetic Bead, Enhancer and Elution Buffer tubes.

**NOTE**

For your convenience, the 4-digit Loading Number (see Figure 10) is displayed on the outside of each component box.

*Figure 10: Loading Number*
NOTE

Before processing starts the AltoStar® AM16 automatically verifies

1) that sufficient reagent volume of the AltoStar® Purification Kit 1.5 components and of the AltoStar® Internal Control 1.5 is present,

2) that the Loading Numbers of the loaded AltoStar® Purification Kit 1.5 components are congruent.

2. Visibly inspect the Lysis Buffer for precipitates. In case precipitates are visible, heat it to below 50 °C. Intermittently pivot the container gently without wetting the seal until precipitates are completely dissolved. Slight color changes may occur to the Lysis Buffer. These slight changes in color do not indicate a change in the quality of the buffer.

3. Vortex the Magnetic Bead tubes for 5 seconds. Avoid wetting the lid. Do not centrifuge the Magnetic Beads.

4. Thaw the required number of IC tubes (AltoStar® Internal Control 1.5) completely and vortex for 5 seconds.

10.6.3 Instrument Loading for a Purification Run

1. Click the Start Run button in the tool bar of the Start Purification Run screen to display the Loading dialog (see Figure 11).

The Loading dialog consists of a visual representation of the AltoStar® AM16 deck at the top and a table specifying the carrier, the respective tracks on the AltoStar® AM16 deck for each carrier, the material for each carrier and comments with respect to the carrier loading.
### Loading

Please load the following labware:

![Loading dialog](image)

<table>
<thead>
<tr>
<th>Carrier</th>
<th>Track</th>
<th>Material</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 - 6</td>
<td>Tips 1000 µl</td>
<td>Replace empty Tip Racks with completely filled new ones</td>
</tr>
<tr>
<td>2</td>
<td>7 - 12</td>
<td>Tips 300 µl</td>
<td>Replace empty Tip Racks with completely filled new ones</td>
</tr>
<tr>
<td>2</td>
<td>7 - 12</td>
<td>Elute Plate</td>
<td>New Elute Plate</td>
</tr>
<tr>
<td>3 - 4</td>
<td>13 - 16</td>
<td>Lysis Buffer Wash Buffer 1 Wash Buffer 2 Wash Buffer 3</td>
<td>One or several containers of each buffer anywhere on these carriers</td>
</tr>
<tr>
<td>5</td>
<td>17</td>
<td>Enhancer Internal Control Magnetic Beads Elution Buffer</td>
<td>One or several tubes of each component anywhere on this carrier</td>
</tr>
<tr>
<td>6 - 11</td>
<td>18 - 23</td>
<td>Samples</td>
<td>10 samples on up to 6 carriers</td>
</tr>
<tr>
<td>12</td>
<td>24 - 30</td>
<td>Processing Plate</td>
<td>One new Processing Plate</td>
</tr>
<tr>
<td>12</td>
<td>24 - 30</td>
<td>Tip Rack Plate</td>
<td>One new Processing Plate</td>
</tr>
<tr>
<td>12</td>
<td>24 - 30</td>
<td>Tip Rack</td>
<td>Empty unused Tip Rack</td>
</tr>
</tbody>
</table>

- [ ] Reset 1000 µl tip counter
- [ ] Reset 300 µl tip counter

**Figure 11:** Loading dialog
NOTE
To visualize the position of an item on a carrier and the position of the carrier on the AltoStar® AM16 deck, select the respective row of the table in the Loading dialog. The position of the item and its carrier is visualized:
1) Highlighted in red in the visual representation of the instrument deck.
2) On the AltoStar® AM16 by flashing Loading Lights above the tracks where the selected carrier must be placed.

2. Load the material, prepared reagents and prepared samples onto the suitable carriers as follows:

<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 6</td>
<td>One Tip Carrier</td>
<td>5 x 1000 μl Tip Racks</td>
</tr>
</tbody>
</table>

- Exchange only **completely empty** 1000 μl Tip Racks for **completely full** 1000 μl Tip Racks on the Tip Carrier.

NOTE
Exchange of Tip Racks, which are not completely empty as well as handling of individual tips may interfere with the automatic tip management and cause run aborts.
<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 - 12</td>
<td>One Tip and Plate Carrier</td>
<td>3 x 300 μl Tip Racks 1 x Eluate Plate</td>
</tr>
</tbody>
</table>

- Exchange only **completely empty** 300 μl Tip Racks for **completely full** 300 μl Tip Racks on the Tip and Plate Carrier.
- Place the Eluate Plate with well A1 to the left of the black plate position. The plate position at the front is not used during Purification Runs.

**NOTE**

Exchange of Tip Racks, which are not completely empty as well as handling of individual tips may interfere with the automatic tip management and cause run aborts.
<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
</table>
| 13 - 16 | One or two Container Carriers | up to 8 containers of:  
  - Lysis Buffer  
  - Wash Buffer 1  
  - Wash Buffer 2  
  - Wash Buffer 3 |

- Load one or two Container Carriers with up to eight containers of Lysis Buffer, Wash Buffer 1, Wash Buffer 2 and Wash Buffer 3.
- Gently push the containers all the way to the bottom of the carrier.
- Remove and dispose of all sealing foils from the containers.

**NOTE**

Starting a Purification Run with the sealing foils still on the containers may cause the run to abort during processing.

**NOTE**

The position of the individual containers on the respective carriers is arbitrary.
<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>One Tube Carrier 24</td>
<td>up to 24 tubes of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IC (Internal Control)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Magnetic Beads</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enhancer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Elution Buffer</td>
</tr>
</tbody>
</table>

- Load a Tube Carrier 24 with up to 24 tubes of IC, Magnetic Beads, Enhancer and Elution Buffer.
- Gently push the tubes all the way to the bottom of the carrier and rotate the tubes until the tube barcodes are visible through the carrier windows.
- Remove all lids from the tubes and store them for reuse.
- Store the lids for reuse in a clean space.

**NOTE**

Reuse of lids for any other tube than the original one may lead to cross-contamination.

**NOTE**

The position of the individual tubes on the carrier is arbitrary.

**NOTE**

Starting a Purification Run with lids still on the tubes may cause the run to abort during processing.
<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>18 - 23</td>
<td>One to six Tube Carrier 32 for sample tubes of 11 - 14 mm diameter</td>
<td>Prepared samples for the Purification Run to be started</td>
</tr>
<tr>
<td></td>
<td>One to six Tube Carrier 24 for sample tubes of 14.5 - 18 mm diameter</td>
<td></td>
</tr>
</tbody>
</table>

- Load the prepared samples for the Purification Run on up to six sample carriers. Two carrier types can be used in parallel in the same run:
  - For sample tubes of 11 - 14 mm outer diameter use the Tube Carrier 32.
  - For sample tubes of 14.5 - 18 mm outer diameter use the Tube Carrier 24.
- Gently push the tubes all the way to the bottom of the carrier and rotate the tubes until the tube barcodes are visible through the carrier windows.

**NOTE**

The position of the individual tubes on the carriers is arbitrary.

**NOTE**

Starting a Purification Run with lids still on the tubes may cause the run to abort during processing.
### Track | Carrier Description | Material to be loaded
--- | --- | ---
24 - 30 | Heater Shaker Carrier | 1 x AltoStar® Processing Plate 1 x Tip Park Plate 1 x Tip Park Rack

- Place an unused Tip Park Plate at the bottom of the front position and an unused Tip Park Rack at the top of the front position and ensure both items are latched into their respective position.
- Place an unused AltoStar® Processing Plate at the second position from the front and ensure it is latched into position.

3. Load the carriers with the carrier barcode towards the rear facing right.
4. Insert populated carriers into the respective tracks between the front and rear slide blocks of the Loading Tray until they touch the stop hooks on the far side of the Loading Tray.

**NOTE**

Pushing the carriers past the stop hooks may damage the instrument and interfere with the loading process.

5. Check that the Tip Eject Sheet and the Tip Waste Container are in the correct position and a new Waste Bag is placed in the container.
6. Click **Ok** in the **Loading** dialog to proceed with the loading process.
NOTE

By clicking Cancel the Purification Run will be cancelled, but it can be started again (see chapter 10.6 Starting a Purification Run).

The Tip Park Plate dialog is displayed (see Figure 12).

Figure 12: Tip Park Plate dialog
7. Scan the Tip Park Plate barcode in duplicate with the handheld barcode scanner to ensure that the plate has not been used in prior runs.

8. Click **Ok** to confirm the input.

The AltoStar® AM16 draws the carriers into the instrument and performs barcode and reagent volume verifications.

**NOTE**

The AltoStar® AM16 automatically verifies:

1) Correct type and localization of the loaded carriers

2) Correct identity and position of the items loaded on the carriers

3) Lot congruence of the AltoStar® Purification Kit 1.5 components (Lysis Buffer, Wash Buffers, Magnetic Beads, Enhancer and Elution Buffer)

4) Non-expiry of all loaded reagents

5) Presence of sufficient reagent volumes

6) Singularity of sample barcodes

7) Correct positioning of the items loaded manually on the Heater Shaker Carrier

8) Correct positioning of the Tip Eject Sheet

If any of these checks fail, the user is prompted with a message dialog specifying the problem at hand and instructions to correct the issue accordingly. For further information regarding error handling refer to the AltoStar® Connect Software Manual IVD (Hamilton, chapter 4 Troubleshooting and Error Messages).

**NOTE**

Altering of positions of any loaded item after the carrier has been drawn into the instrument results in abort of the Purification Run and damage to the instrument.

When all checks have passed the **Loading complete** dialog is displayed (see Figure 13).
9. Confirm the **Loading complete** dialog by clicking **Ok** or wait 10 seconds for the automatic start of the process.

**NOTE**

By clicking **Cancel** the Purification Run will be cancelled, but it can be started again (see chapter 10.6 Starting a Purification Run).

The Purification Run is started and will be conducted without user intervention.
10.7 During the Purification Run

No further user interaction is required until the Purification Run has finished. The **Processing Status Screen** is displayed (see Figure 14) showing the status of the Purification Run and the estimated time remaining.

![Figure 14: Processing Status Screen](image)

**NOTE**

Pushing or pulling carriers or the door of the AltoStar® AM16 during a Purification Run may abort the run.

**NOTE**

Aborting the Purification Run after the **Loading complete** dialog is confirmed will void the AltoStar® Run, preventing a restart. To repeat aborted runs see the AltoStar® Connect Software Manual IVD (Hamilton, chapter 3.8.14 Purification Results).
### NOTE

After the sample transfer into the AltoStar® Processing Plate has finished, the sample carrier(s) can be unloaded at any time. The **Unload samples** button in the tool bar will be active and can be clicked. The sample carrier(s) will be unloaded from the deck and the sample tubes can be removed. The Purification Run will not be interrupted.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required components of the AltoStar® Parvovirus B19 PCR Kit 1.5 for the subsequent PCR Setup Run can be previewed to allow for preparation of these components during the preceding Purification Run:</td>
</tr>
<tr>
<td>1. Click <strong>PCR Setup → Start PCR Setup</strong> in the menu bar to access the Start PCR Setup Run Screen.</td>
</tr>
<tr>
<td>2. Refer to the tables <strong>Controls in selected PCR Setup Run</strong> and <strong>Required master tubes for the selected PCR Setup Run</strong> for information on the required components.</td>
</tr>
<tr>
<td>3. Return to the ongoing Purification Run by clicking <strong>Purification → Current Purification</strong> in the menu bar.</td>
</tr>
</tbody>
</table>
10.8 End of the Purification Run

At the end of the Purification Run the **Run finished** dialog is displayed (see Figure 15).

![Run finished dialog](image)

**Figure 15**: Run finished dialog

1. Make sure that the Loading Tray is empty.
2. Confirm the **Run finished** dialog by clicking **Ok**.

The AltoStar® AM16 will unload the carriers. Make sure not to stand in the way of the unloading carriers.

After unloading the **Maintenance** dialog is displayed (see Figure 16).

3. Follow the instructions of the **Maintenance** dialog.
The table of the dialog displays components of the AltoStar® Purification Kit 1.5 and the IC (AltoStar® Internal Control 1.5) with sufficient volume to be used again in subsequent Purification Runs.

1. If a PCR Setup Run using the currently loaded Eluate Plate is to be started directly after the Purification Run, the Eluate Plate can remain on the carrier position at room temperature (max. 30 °C) up to 6 hours. If the PCR Setup Run is not started directly after the Purification Run, seal and store the Eluate Plate as described in chapter 10.10.2 Sealing of the Eluate Plate.

2. Close tubes with the appropriate tube caps. Avoid interchanging the tube caps when closing the reagents after use.


4. Store reagents for reuse as described in the chapters 4 Storage and Handling in the Instructions for Use of the AltoStar® Purification Kit 1.5 and the AltoStar® Internal Control 1.5, respectively.

5. Dispose of the components of the AltoStar® Purification Kit 1.5 and the AltoStar® Internal Control 1.5 not listed in the table.

Dispose of the samples and used materials (see chapter 11 Disposal).

6. Confirm the Maintenance dialog by clicking Ok.
CAUTION

Always treat samples as infectious and (bio-)hazardous in accordance with safe laboratory procedures. For sample material spills promptly use an appropriate disinfectant. Handle contaminated materials as biohazardous.

NOTE

Liquid waste and any liquids containing Lysis Buffer or Wash Buffer 1 contain guanidine thiocyanate, which can form toxic, highly reactive and volatile compounds when combined with bleach or strong acids.

NOTE

The instructions for the daily maintenance procedure for the disposal of liquid waste and used materials can be found in the AltoStar® AM16 Operator’s Manual IVD (Hamilton, chapter 3.5 Maintenance).
10.9 Purification Run Results

The Purification Run results are saved in the AltoStar® Connect software.

1. Click **Purification → Purification Results** in the menu bar to access the Results Screen (see Figure 17).

![Results Screen](image)

The Results Screen displays a table with all samples used in the latest Purification Run and a column **Status** at the right showing if the Purification Run for a given sample was conducted completely (see Table 6).
### Table 6: Purification Run Results

<table>
<thead>
<tr>
<th>Status</th>
<th>Purification Run Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processed</td>
<td>• The sample was successfully processed in the Purification Run.</td>
</tr>
<tr>
<td></td>
<td>• The respective eluate is ready for use in a PCR Setup Run.</td>
</tr>
<tr>
<td>Error</td>
<td>• The sample was not processed successfully.</td>
</tr>
<tr>
<td></td>
<td>• No eluate of this sample is available.</td>
</tr>
<tr>
<td></td>
<td>• The sample will be automatically omitted from following PCR Setup Runs.</td>
</tr>
</tbody>
</table>

2. To view the results of prior Purification Runs, click the **Load** button in the menu bar, select the desired Purification Run from the list in the opening **Load Results** dialog and click **Ok**.

Two Purification Run result files are automatically generated by the AltoStar® Connect software:

- A LIMS file (.xml) to pass detailed information about the Purification Run including results back to the LIMS.
- A report (.pdf) containing detailed information about the Purification Run including results for documentation purposes.

These files are saved to the location specified in the System Settings of the AltoStar® Connect software.

**NOTE**

Purification Run result files can be generated again by loading the respective Purification Run and clicking the **Create LIMS File** button to generate the LIMS file or the **Create Report** button to generate the report.
10.10 Eluate Stability
After completion of the Purification Run the eluates in the unsealed Eluate Plate are stable at room temperature (max. 30 °C) for a total of 6 hours.

**CAUTION**

Storage of eluates under wrong conditions may lead to degradation of the parvovirus B19 target sequence.

10.10.1 Storage
The eluates in a sealed Eluate Plate (see chapter 10.10.2 Sealing of the Eluate Plate) can be stored at 2 °C - 8 °C for up to 24 hours before the start of a PCR Setup Run.

**CAUTION**

Storage of eluates under wrong conditions may lead to degradation of the parvovirus B19 target sequence.

10.10.2 Sealing of the Eluate Plate
In case the eluates in the Eluate Plate are to be stored, the plate must be sealed with AltoStar® Eluate Plate Sealing Foil. It is recommended to use the AltoStar® Plate Sealer. The suitability of plate sealers other than the AltoStar® Plate Sealer has to be evaluated by the user.

**NOTE**

Using unsuitable plate sealers or sealing parameters may damage the eluates as well as the Eluate Plate, the AltoStar® Eluate Plate Sealing Foil and the plate sealer.
If the AltoStar® Plate Sealer is used for sealing, proceed as follows:

1. Turn on the AltoStar® Plate Sealer and make sure that the plate adapter is not in the drawer.

2. Ensure that the settings of the AltoStar® Plate Sealer are as follows: 170 °C and 2 seconds.

3. Wait until the set temperature of 170 °C is reached. This may take several minutes.

4. Place the Eluate Plate on the plate adapter of the AltoStar® Plate Sealer.

5. Place one AltoStar® Eluate Plate Sealing Foil on the Eluate Plate. Align the cut corner of the sealing foil with the cut corner of the Eluate Plate. Make sure that all wells of the Eluate Plate are covered with foil. Please take special care that the well at the cut corner is covered properly.

NOTE

Operating the AltoStar® Plate Sealer without the plate adapter placed in the drawer may render the sealer nonfunctional. In this case contact altona Diagnostics Technical Support for assistance (see chapter 14 Technical Assistance).

NOTE

If the AltoStar® Eluate Plate Sealing Foil or the frame is placed incorrectly, the foil may stick to the heating plate within the AltoStar® Plate Sealer during sealing. This will render the sealer nonfunctional. In this case let the AltoStar® Plate Sealer cool down to room temperature and contact altona Diagnostics Technical Support for assistance (see chapter 14 Technical Assistance).

6. Assemble the sealing frame on top to hold down the sealing foil.

7. Open the drawer via the Operate button.

8. Place the assembly consisting of the plate adapter, the Eluate Plate, the AltoStar® Eluate Plate Sealing Foil and the sealing frame into the AltoStar® Plate Sealer and press the Operate button.

9. The drawer closes automatically, seals for 2 seconds and reopens automatically.

10. Take the sealed Eluate Plate and the plate adapter out of the AltoStar® Plate Sealer and close the AltoStar® Plate Sealer by pressing the Close button.
10.10.3 Unsealing of the Eluate Plate

Remove the AltoStar® Eluate Plate Sealing Foil from the Eluate Plate as follows:

1. Briefly centrifuge the Eluate Plate in a plate centrifuge to remove any liquid from the inside of the sealing foil.
2. Press the Eluate Plate onto a table to avoid sudden plate movements during the removal of the sealing foil.
3. Start peeling in one corner and slowly and steadily pull the sealing foil towards the diagonally opposite corner until it is removed.

10.11 Starting a PCR Setup Run

1. Select PCR Setup → Start PCR Setup in the menu bar. Alternatively, go back to the Start Screen of the AltoStar® Connect software and select the Start PCR Setup button. The Start PCR Setup Run Screen is displayed (see Figure 18).

The pending PCR Setup Runs are displayed in the Programmed PCR Setup Runs table on the left side of the screen.
Figure 18: Start PCR Setup Run Screen

2. Select the PCR Setup Run to be started in the **Programmed PCR Setup Runs** table.

   - The samples included in the selected PCR Setup Run are displayed in the table on the top right side of the screen (Samples in selected PCR Setup Run).

   - The Quantification Standards and Controls required for the selected PCR Setup Run are displayed in the table on the middle right side of the screen (Controls in selected PCR Setup Run).

   - The number of master tubes required for the selected PCR Setup Run is displayed in the table on the bottom right side of the screen (Required master tubes for the selected PCR Setup Run).
NOTE

The number of prioritized samples in a PCR Setup Run is displayed in the column No. of prioritized Samples. Conduct PCR Setup Runs with prioritized samples first to facilitate fastest processing of prioritized samples.

Before clicking the Start Run button in the tool bar, prepare the required reagents as described in chapter 10.12 Preparing Reagents for a PCR Setup Run. If the Eluate Plate required for the selected PCR Setup Run has been sealed for storage prepare it as described in chapter 10.10.3 Unsealing of the Eluate Plate.

10.12 Preparing Reagents for a PCR Setup Run

1. Thaw the required Quantification Standards, Controls and the required number of Master tubes completely at room temperature (max. 30 °C).
2. Mix the reagents by gentle vortexing.
3. Centrifuge the tubes briefly to remove drops from the lid.

CAUTION

A lack of centrifugation of the product components after thawing could lead to contamination of the components with reagent residues in the lids and as consequence to a compromised product performance.
10.12.1 Loading the AltoStar® AM16 for a PCR Setup Run

1. Click the **Start Run** button in the tool bar of the **Start PCR Setup Run Screen** to display the **Loading** dialog (see Figure 19).
The **Loading** dialog consists of a visual representation of the AltoStar® AM16 deck at the top and a table specifying the carriers, the respective tracks on the AltoStar® AM16 deck for each carrier, the material to be loaded onto each carrier and comments with respect to the carrier loading.

### NOTE

To visualize the position of an item on a carrier and the position of the carrier on the AltoStar® AM16 deck, select the respective row of the table in the **Loading** dialog.

The position of the item and its carrier is visualized:

1) Highlighted in red in the visual representation of the instrument deck.

2) On the AltoStar® AM16 by flashing Loading Lights above the tracks where the selected carrier must be placed.

2. Load the required material, the prepared Eluate Plate and the prepared reagents onto the suitable carriers as follows:
AltoStar® Parvovirus B19 PCR Kit 1.5

<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 6</td>
<td>One Tip Carrier</td>
<td>5 x 1000 µl Tip Racks</td>
</tr>
</tbody>
</table>

- Exchange only **completely empty** 1000 µl Tip Racks for **completely full** 1000 µl Tip Racks on the Tip Carrier.

**NOTE**

Exchange of Tip Racks, which are not completely empty as well as handling of individual tips may interfere with the automatic tip management and cause run aborts.
<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
</table>
| 7 - 12 | One Tip and Plate Carrier | 3 x 300 μl Tip Racks  
1 x Eluate Plate  
1 x PCR Plate |

- Exchange only **completely empty** 300 μl Tip Racks for **completely full** 300 μl Tip Racks on the Tip and Plate Carrier.
- Place the required Eluate Plate with well A1 to the left of the black plate position.
- Place a PCR Plate with well A1 to the left of the silver front plate position.

**NOTE**

Exchange of Tip Racks, which are not completely empty as well as handling of individual tips may interfere with the automatic tip management and cause run aborts.
<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>One Tube Carrier 24</td>
<td>1 Pooling Tube per assay</td>
</tr>
</tbody>
</table>

- Load a Tube Carrier 24 with one unused Pooling Tube for each assay in the PCR Setup Run.
- Gently push the tubes all the way to the bottom of the carrier and rotate the tubes until the tube barcodes are visible through the carrier window.

**NOTE**

The position of the individual tubes on the carrier is arbitrary.
<table>
<thead>
<tr>
<th>Track</th>
<th>Carrier Description</th>
<th>Material to be loaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>14 - 17</td>
<td>One to four Reagent Tube Carrier 32</td>
<td>Assay components</td>
</tr>
</tbody>
</table>

- Load the Reagent Tube Carrier 32 with the assay components required for the PCR Setup Run.
- Gently push the tubes all the way to the bottom of the carrier and rotate the tubes until the tube barcodes are visible through the carrier window.

**NOTE**
The position of the individual tubes on the carriers is arbitrary.

**NOTE**
The volume of the loaded components is not checked by the system prior to processing. Insufficient component volume will prevent successful PCR setup for the affected assay.

**NOTE**
Starting a PCR Setup Run with lids still on the tubes may cause the run to abort during processing.
3. Load the carriers with the carrier barcode towards the rear facing right.

4. Insert populated carriers into the respective tracks between the front and rear slide blocks of the Loading Tray until they touch the stop hooks on the far side of the Loading Tray.

**NOTE**

Pushing the carriers past the stop hooks may damage the instrument and interfere with the loading process.

5. Check that the Tip Eject Sheet and the Tip Waste Container are in the correct position and a new Waste Bag is placed in the container.

6. Click **Ok** in the **Loading** dialog to proceed with the loading process.

**NOTE**

By clicking **Cancel** the PCR Setup Run will be cancelled, but it can be started again (see chapter 10.11 Starting a PCR Setup Run).

The AltoStar® AM16 draws the carriers into the instrument and performs barcode verification.

**NOTE**

The AltoStar® AM16 automatically verifies:

1) Correct type and localization of the loaded carriers.

2) Correct identity and position of the items loaded on the carriers.

3) Lot congruence of the components of the individual AltoStar® assay kits.

4) Non-expiry of all loaded AltoStar® assay components.

5) Correct positioning of the Tip Eject Sheet.
If any of these checks fail, the user is prompted with a message dialog specifying the problem at hand and instructions to correct the issue accordingly. For further information regarding error handling refer to the AltoStar® Connect Software Manual IVD (Hamilton, chapter 4 Troubleshooting and Error Messages).

**NOTE**

- Altering positions of any loaded item after the carrier has been drawn into the instrument may result in the abort of the PCR Setup Run and/or damage to the instrument.

When all checks have passed the **Loading complete** dialog is displayed (see Figure 20).

![Figure 20: Loading complete dialog](image)

7. Confirm the **Loading complete** dialog by clicking **Ok** or wait 10 seconds for the automatic start of the process.

**NOTE**

- By clicking **Cancel** the PCR Setup Run will be cancelled, but it can be started again (see chapter 10.11 Starting a PCR Setup Run).

The PCR Setup Run is started and will be conducted without user intervention.
10.13 During the PCR Setup Run

No further user interaction is required until the PCR Setup Run has finished. The Processing Status Screen is displayed (see Figure 21) showing the status of the PCR Setup Run and the estimated time remaining.

![Processing Status Screen](image)

**Figure 21: Processing Status Screen**

**NOTE**

Pushing or pulling carriers or the door of the AltoStar® AM16 during a PCR Setup Run may abort the run.
10.14 End of the PCR Setup Run

At the end of the PCR Setup Run the **Run finished** dialog is displayed (see Figure 22).

![Run finished dialog](image)

**Figure 22**: Run finished dialog

1. Make sure that the Loading Tray is empty.
2. Confirm the **Run finished** dialog by clicking **Ok**.

The AltoStar® AM16 will unload the carriers. Make sure not to stand in the way of the unloading carriers.

After unloading the **Maintenance** dialog is displayed (see Figure 23).

3. Follow the instructions of the **Maintenance** dialog.
The table of the dialog displays the number of reactions in the Master tubes that were not used in the PCR Setup Run.

4. If another PCR Setup Run using the currently loaded Eluate Plate is to be started right away, the Eluate Plate can remain unsealed on the carrier position. If this is not the case, seal and store the Eluate Plate as described in chapter 10.10.2 Sealing of the Eluate Plate.

**NOTE**
The eluates in the Eluate Plate are stable at room temperature (max. 30 °C) for a total of 6 hours after completion of the Purification Run.

5. Close reagent tubes with suitable unused tube caps.

**CAUTION**
Do not reuse tube caps to avoid contamination of the reagents.

6. Store reagents for reuse as described in chapter 4.2 Handling.
7. Dispose of the used materials (see chapter 11 Disposal).
8. Confirm the Maintenance dialog by clicking Ok.
10.15 PCR Setup Run Results

The PCR Setup Run results are saved in the AltoStar® Connect software.

1. Click **PCR Setup → PCR Setup Results** in the menu bar to access the Results Screen (see Figure 24).

![Results Screen](image)

**Figure 24: Results Screen**

The Results Screen displays a table with all samples used in the latest PCR Setup Run and a column **Status** at the right showing if the PCR Setup process for a given sample was conducted completely (see Table 7).
Table 7: PCR Setup Run Results

<table>
<thead>
<tr>
<th>Status</th>
<th>PCR Setup Run Result</th>
</tr>
</thead>
</table>
| Processed | • The eluate was successfully processed in the PCR Setup Run.  
|          | • The resulting PCR Mix is ready for use in a PCR Run. |
| Error   | • The eluate was not processed successfully.  
|          | • The respective PCR Mix will be automatically omitted in the following PCR analysis. |

2. To view the results of prior PCR Setup Runs, click the **Load** button in the menu bar, select the desired PCR Setup Run from the list in the opening **Load Results** dialog and click **Ok**.

Three PCR Setup Run result files are automatically generated by the AltoStar® Connect software:

- A LIMS file (.xml) to pass detailed information about the PCR Setup Run including results back to the LIMS
- A report (.pdf) containing detailed information about the PCR Setup Run including results for documentation purposes
- A cycler file (.plrn) for automatic programming of the CFX96™ DW Dx

These files are saved to the location specified in the System Settings of the AltoStar® Connect software.

**NOTE**

PCR Setup Run result files can be generated again by loading the respective PCR Setup Run and clicking the **Create LIMS File** button to generate the LIMS file, the **Create Report** button to generate the report or the **Create Bio-Rad Cycler File** button to generate the Cycler File.
10.16 Sealing of the PCR Plate

After completion of the PCR Setup Run, the PCR Plate must be sealed with AltoStar® PCR Plate Sealing Foil. It is recommended to use the AltoStar® Plate Sealer. The suitability of plate sealers other than the AltoStar® Plate Sealer has to be evaluated by the user.

If the AltoStar® Plate Sealer is used for sealing, proceed as follows:

1. Switch on the AltoStar® Plate Sealer and make sure that the plate adapter is not in the drawer.
2. Ensure that the settings of the AltoStar® Plate Sealer are as follows: 170 °C and 2 seconds.
3. Wait until the set temperature of 170 °C is reached. This may take several minutes.
4. Place the PCR Plate on the plate adapter of the AltoStar® Plate Sealer.
5. Place one AltoStar® PCR Plate Sealing Foil on the PCR Plate. Align the cut corner of the sealing foil with the cut corner of the PCR Plate. Make sure that all wells of the PCR Plate are covered with foil. Please take special care that the well at the cut corner is covered properly.

**NOTE**

Operating the AltoStar® Plate Sealer without the plate adapter placed in the drawer may render the sealer nonfunctional. In this case contact altona Diagnostics Technical Support for assistance (see chapter 14 Technical Assistance).

**NOTE**

If the AltoStar® PCR Plate Sealing Foil or the frame is placed incorrectly, the foil may stick to the heating plate within the AltoStar® Plate Sealer during sealing. This will render the sealer nonfunctional. In this case let the AltoStar® Plate Sealer cool down to room temperature and contact altona Diagnostics Technical Support for assistance (see chapter 14 Technical Assistance).

6. Assemble the sealing frame on top to hold down the sealing foil.
7. Open the drawer by pressing the Operate button.
8. Place the assembly consisting of the plate adapter, the PCR Plate, the AltoStar® PCR Plate Sealing Foil and the sealing frame into the AltoStar® Plate Sealer and press the Operate button.

9. The drawer closes automatically, seals for 2 seconds and reopens automatically.

10. Take the sealed PCR Plate and the plate adapter out of the AltoStar® Plate Sealer and close the AltoStar® Plate Sealer by pressing the Close button.

10.17 PCR Mix Stability

After completion of the PCR Setup Run the PCR Mix in the sealed PCR Plate is stable at room temperature (max. 30 °C) for max. 30 minutes.

**CAUTION**

Do not exceed the PCR Mix storage time. This could lead to a compromised product performance.
10.18 Starting a PCR Run

The PCR Run is performed on a CFX96™ DW Dx under control of the CFX Manager™ Dx software.

1. Switch on the CFX96™ DW Dx, the attached computer and the monitor.
2. Start the CFX Manager™ Dx software.
3. In the menu bar of the CFX Manager™ Dx software select File → Open → LIMS File… to open the Open LIMS File dialog (see Figure 25).

![CFX Manager™ Dx software window](image)

Figure 25: CFX Manager™ Dx software window
4. In the opening **Open LIMS File** dialog, make sure that the cursor is blinking in the **File name** field at the bottom (see Figure 26). If it is not, click into the **File name** field.

![Figure 26: Open LIMS File dialog](image)

5. Scan the PCR Plate barcode with the handheld barcode scanner to automatically select and open the correct LIMS file. The **Run Setup** dialog is displayed (see Figure 27).

**NOTE**

All parameters required for the start of the PCR Run are transferred automatically from the AltoStar® Connect software to the CFX96™ DW Dx by means of the cycler file.
6. Click **Open Lid** to open the lid of the CFX96™ DW Dx (see Figure 27).

![Figure 27: Run Setup dialog](image)

7. Briefly centrifuge the sealed PCR Plate to ensure all liquid is at the bottom of the wells.

8. Insert the sealed PCR Plate into the heating block of the CFX96™ DW Dx with well A1 to the left side.

9. Close the CFX96™ DW Dx by clicking the **Close Lid** button in the Run Setup dialog (see Figure 27).

10. Start the PCR Run by clicking the **Start Run** button in the Run Setup dialog (see Figure 27).
10.19 During the PCR Run

No user interaction is required until the PCR Run has finished. The Run Details dialog is displayed (see Figure 28) showing the status of the PCR Run and the estimated time remaining.

![Run Details dialog](image)

**Figure 28**: Run Details dialog

**NOTE**

Opening the lid of the CFX96™ DW Dx during a PCR Run by operating the button at the front of the lid or by clicking **Open Lid** in the Run Details dialog will abort the run and void all results.
At the end of the PCR Run the Data Analysis window is displayed (see Figure 29).

**Figure 29**: Data Analysis window

10.20 Assigning Assays to Well Groups

The AltoStar® Workflow processes one or several PCR assays simultaneously on one PCR Plate. However, each assay must be analyzed separately by the user according to the Instructions for Use of the respective assay.

To this end, all assays on a PCR Plate must be assigned to individual Well Groups in the CFX Manager™ Dx software by the user.
1. In the **Data Analysis** window (see Figure 29) click the **Plate Setup** button in the tool bar and select **View/Edit Plate**. The **Plate Editor** dialog is displayed (see Figure 30).

2. In the **Plate Editor** dialog click **Well Groups** in the tool bar. The **Well Groups Manager** dialog is displayed (see Figure 31).

3. Click the **Add** button.

4. Type the name of the first assay in the text box.

5. Select all wells in the PCR Plate area that belong to the first assay (see Figure 31). The wells belonging to an individual assay can be identified in the **Plate Editor** dialog by the entry in the **Biological Set** field.
6. Repeat steps 3 to 5 for all assays on the PCR Plate.

7. Confirm Well Group assignment by clicking **OK**. The **Well Groups Manager** dialog closes.

8. Close the **Plate Editor** dialog by clicking **OK**.

9. Confirm to apply the changes by clicking **Yes** (see Figure 32).
10.21 PCR Data Analysis

The results of all assays (Well Groups) on the PCR Plate have to be analyzed in the sequence depicted in Figure 33.

**Selection of the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5**

**Run Analysis according to these Instructions For Use**

- **Baseline correction** for the FAM™ (Parvovirus B19) and VIC™ (Internal Control) detection channels
- **Exclusion of all wells showing irregular PCR signals** (e.g., linear signal increase, signal spikes, etc.)
- **Setting of thresholds** for the FAM™ (Parvovirus B19) and VIC™ (Internal Control) detection channels according to the controls
- **Exclusion of all wells that do not contain valid data** according to laboratory specifications and the specifications given in these Instructions For Use

**If result interpretation is performed by the LIMS**

- Export of PCR results as LIMS Result File (.csv)

**If result interpretation is performed manually by the user**

- Export of PCR results as Report (.pdf)
- Result interpretation (e.g., calculation of sample concentrations)

**Selection of the next assay (Well Group) to be analyzed**

*Figure 33: PCR Data Analysis process*
In the **Data Analysis** window (see Figure 29) ensure to select the **Well Group** of the AltoStar® Parvovirus B19 PCR Kit 1.5. Therefore, click on the **Well Group** drop-down menu right next to the **Well Group** button (see Figure 34) of the toolbar. Do not use the “**All Wells**” Well Group.

Before analyzing the results ensure that the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5 contains all of the AltoStar® Parvovirus B19 PCR Kit 1.5 wells and no wells of other assays.

![Figure 34: Well Group button and Well Group drop-down menu](image)

**NOTE**

Combined analysis of more than one assay may lead to incorrect results.

**CAUTION**

As with any diagnostic test, results should be interpreted in consideration of all clinical and laboratory findings.

### 10.21.1 Baseline Correction

The baseline settings used by the CFX Manager™ Dx software may have to be corrected for individual wells of the assay (**Well Group**) under analysis.

1. In the Data Analysis Window (see Figure 29) ensure to select the **Well Group** of the AltoStar® Parvovirus B19 PCR Kit 1.5. Therefore, click on the **Well Group** drop-down menu right next to the **Well Group** button (see Figure 34) of the toolbar.

2. At the left side of the **Data Analysis** window tick only the **FAM** checkbox for the parvovirus B19 target detection channel (see Figure 29).
3. In the menu bar of the **Data Analysis** window click **Settings → Baseline Threshold…** to open the **Baseline Threshold** dialog (see Figure 35).

4. Click the ◊ symbol in the **Baseline End** column header once to sort the table by ascending **Baseline End** values.

5. Select all lines that show a **Baseline End** value of 1 to 9 (see Figure 35).

![Baseline Threshold dialog](image)

**Figure 35**: Baseline Threshold dialog

6. Set the value in the **End** field to 45 for the selected lines (see Figure 35).

7. Confirm the settings by clicking **OK**.

8. At the left side of the **Data Analysis** window untick the **FAM** checkbox and tick only the **VIC** checkbox for the Internal Control target detection channel.

9. Repeat steps 3 to 7 for the **VIC™** (Internal Control) detection channel.
10.21.2 Exclusion of Irregular PCR Signals

Valid results can only be derived from PCR signals that are free of signal artefacts, which may be caused e.g. by impurities or bubbles in the PCR Mix. PCR signals that contain signal artefacts have to be excluded by the user.

1. In the Data Analysis window (see Figure 29) ensure to select the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right next to The Well Group button (see Figure 34) of the toolbar.

2. Identify wells with irregular PCR signals (linear signal increase, signal spikes, etc.) in any of the FAM™ (parvovirus B19 target) and the VIC™ (Internal Control) detection channels (see Figure 36).
**Figure 36**: Data Analysis window: Irregular PCR signal
3. Click each affected well with the right mouse button and select Well... → Exclude from Analysis (see Figure 37).

![Figure 37: Data Analysis window: Exclude Well from Analysis](image)
4. The selected well is excluded from the analysis. No results will be generated for this well (see Figure 38).

Figure 38: Data Analysis window: Excluded well
10.21.3 Setting of Thresholds

The thresholds for the FAM™ (parvovirus B19 target) and the VIC™ (Internal Control) detection channels have to be set manually by the user according to the signals of the controls.

1. In the Data Analysis Window (see Figure 29) ensure to select the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right next to the Well Group button (see Figure 34) of the toolbar.

2. At the left side of the Data Analysis window tick only the VIC checkbox for the detection channel of the Internal Control (see Figure 39).
3. Select only the NTC well in the plate view of the Data Analysis window (see Figure 39).

4. Drag the threshold into the exponential area of the NTC signal (see Figure 39).
NOTE

The NTC contains Internal Control Template, which leads to an Internal Control signal in a valid NTC well.

5. At the left side of the Data Analysis window untick the VIC checkbox and tick the FAM checkbox for the detection channel of the parvovirus B19 target (see Figure 40).

Figure 40: Data Analysis window: Setting the FAM™ threshold
6. Select only the wells containing the NTC and the Quantification Standards or Positive Control in the plate view of the Data Analysis window (see Figure 40).

7. Drag the threshold well above the signal of the NTC into the exponential area of the Quantification Standards or Positive Control signals.

### 10.21.4 Exclusion of Wells Containing Invalid Data

Wells that do not contain valid data have to be excluded from result generation by the user.

1. In the Data Analysis window (see Figure 29) ensure to select the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right next to the Well Group button (see Figure 34) of the toolbar.

2. Identify all wells containing invalid data. A well is invalid if any of the following conditions apply:

   a) The complete run is invalid (see chapter 10.21.4.1 Validity of a Diagnostic PCR Run (qualitative) and chapter 10.21.4.2 Validity of a Diagnostic PCR Run (quantitative)).

   b) The well data does not meet the control conditions for a valid result (see chapter 10.21.4.3 Validity of Results for a Sample).

3. Click each well containing invalid data according to chapters 10.21.4.1 Validity of a Diagnostic PCR Run to 10.21.4.3 Validity of Results for a Sample with the right mouse button and select Well... → Exclude from Analysis (see Figure 41 and Figure 42).
Figure 41: Data Analysis window: Invalid Well
Figure 42: Data Analysis window: Exclude invalid Well from Analysis
The selected well is excluded from the analysis. No results will be generated for this well (see Figure 43).

Figure 43: Data Analysis window: Excluded Well
10.21.4.1 Validity of a Diagnostic PCR Run (qualitative)

A qualitative diagnostic PCR Run is **valid**, if the following control conditions are met:

<table>
<thead>
<tr>
<th>Control</th>
<th>Detection Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FAM™ (parvovirus B19 target)</td>
</tr>
<tr>
<td>Quantification Standard (Std / Pos)</td>
<td>+</td>
</tr>
<tr>
<td>NTC</td>
<td>-</td>
</tr>
</tbody>
</table>

A qualitative diagnostic PCR Run is **invalid**, if:

- the run has not been completed
- any of the control conditions for a valid qualitative diagnostic PCR Run are not met.

In case of an invalid diagnostic PCR Run, exclude all wells from the analysis and repeat the AltoStar® Run starting from the original samples.

10.21.4.2 Validity of a Diagnostic PCR Run (quantitative)

A quantitative diagnostic PCR Run is **valid**, if the following conditions are met:

- All control conditions for a valid qualitative diagnostic PCR Run are met (see chapter 10.21.4.1 Validity of a Diagnostic PCR Run (qualitative)).
- The generated standard curve reaches the following control parameter value:

<table>
<thead>
<tr>
<th>Control Parameter</th>
<th>Valid Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>R square (R²)</td>
<td>≥ 0.98</td>
</tr>
</tbody>
</table>

The standard curve’s control parameter is displayed below the **Standard Curve** graph in the **Data Analysis** window (see Figure 44).
A quantitative diagnostic PCR Run is invalid, if:

- the run has not been completed
- any of the control conditions for a valid quantitative diagnostic PCR Run are not met.

In case of an invalid diagnostic PCR Run, exclude all wells from the analysis and repeat the AltoStar® Run starting from the original samples.

**10.21.4.3 Validity of Results for a Sample**

The result for an individual sample is invalid, if the signals in both the VIC™ (Internal Control) detection channel and the FAM™ (parvovirus B19 target) detection channel are negative (see Table 10). In case of an invalid result for a sample, exclude the well from the analysis and repeat testing from the original sample or collect and test a new sample.
Table 10: Result validity

<table>
<thead>
<tr>
<th>Detection Channel</th>
<th>Result Validity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>FAM™ (parvovirus B19 target)</td>
<td>VICTM (Internal Control)</td>
</tr>
<tr>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

* Detection of the Internal Control is not required when the parvovirus B19 target is detected. A high parvovirus B19 DNA load in the sample can lead to a reduced or absent Internal Control signal.

10.21.5 Export of PCR Results for Automated Result Interpretation

To make the PCR Run results available to a connected LIMS for automated result interpretation they need to be exported in the form of a LIMS Result File (.csv).

1. In the Data Analysis window (Figure 29) ensure to select the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right next to the Well Group button (see Figure 34) of the toolbar.

2. Ensure that all steps of the analysis process (see chapters 10.21.1 Baseline Correction to 10.21.4 Exclusion of Wells Containing Invalid Data) have been completed for the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5.

3. In the menu bar of the Data Analysis window click Export → Export All Data Sheets to open the Browse For Folder dialog (see Figure 45).
4. In the **Browse For Folder** dialog specify the location for the LIMS Result Files to be generated and click **OK**.

**NOTE**
The LIMS Integration has to be implemented according to the specifications of altona Diagnostics. For information regarding LIMS integration, contact altona Diagnostics Technical Support (see chapter 14 Technical Assistance).

**NOTE**
Saving results of more than one assay (Well Group) from a PCR Run in the same folder leads to replacement of the LIMS Result Files of the first assay (Well Group) with the LIMS Result Files of the second assay (Well Group). In this case the LIMS Result Files of the first assay (Well Group) can be exported again.
10.21.6 Export of PCR Results for Manual Result Interpretation

If the results are not passed to a LIMS for automatic result interpretation, the result interpretation has to be performed manually by the user. To this end the analysis results of each assay (Well Group) need to be exported in the form of a Report.

1. In the Data Analysis Window (see Figure 29) ensure to select the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right next to the Well Group button (see Figure 34) of the toolbar.

2. At the left side of the Data Analysis window tick the VIC checkbox as well as the FAM checkbox.

3. Ensure that all steps of the analysis process (see chapters 10.21.1 Baseline Correction to 10.21.4 Exclusion of Wells Containing Invalid Data) have been completed for the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5.

4. In the menu bar of the Data Analysis window click Tools → Reports... to open the Report dialog (see Figure 46).
Figure 46: Report dialog: Export of the results as Report

5. Ensure that at least the following content is selected for report generation in the upper left part of the Report dialog (see Figure 47):
Select or deselect additional content of the Report by ticking the respective check boxes as required.

6. In the menu bar of the Report dialog click File → Save As... to open the Save Report dialog.

7. In the Save Report dialog specify the name and location for the report file to be generated and click Save.

10.21.6.1 Manual Interpretation of Results

1. Open the Report file generated for the Well Group of the AltoStar® Parvovirus B19 PCR Kit 1.5 (see chapter 10.21.6 Export of PCR Results for Manual Result Interpretation).

2. Refer to the Quantification Data table in the Report (see Figure 48). The table comprises two rows for each Sample - one for the Target parvovirus B19 and one for the Target Internal Control.
Qualitative results would be marked by the term *qualitative* in the Well Note column of the Quantification Data table.

3. In that case, identify each row with the Target *parvovirus B19* and the term *qualitative* in the Well Note column.

4. In these rows, refer to the $C_q$ column for the result of the respective Sample.

5. Refer to Table 11 for interpretation of qualitative results.

Quantitative Results are marked by a *Concentration factor* in the Well Note column of the Quantification Data table (see Figure 48).

6. Identify each row with the Target *parvovirus B19* and a *Concentration factor* in the Well Note column.

7. In these rows, refer to the Starting Quantity (SQ) column for the concentration of the parvovirus B19 target measured in the eluate of the respective Sample. To calculate the result for the original patient sample, the Starting Quantity (SQ) value has to be multiplied by the respective Concentration factor (including the unit) by the user.

8. Refer to Table 12 for interpretation of quantitative results.
### Table 11: Qualitative Results: Result Interpretation

<table>
<thead>
<tr>
<th>Threshold Cycle (C&lt;sub&gt;q&lt;/sub&gt;) of the parvovirus B19 target</th>
<th>Result Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 45</td>
<td>Parvovirus B19 specific DNA detected.</td>
</tr>
<tr>
<td>N/A</td>
<td>No parvovirus B19 specific DNA detected. Sample does not contain detectable amounts of parvovirus B19 specific DNA.</td>
</tr>
</tbody>
</table>

### Table 12: Quantitative Results: Result Interpretation

<table>
<thead>
<tr>
<th>Starting Quantity (SQ) of the parvovirus B19 target</th>
<th>Result Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 0</td>
<td>Parvovirus B19 specific DNA detected. Multiply the Starting Quantity (SQ) value by the Concentration factor in the Well Note column (including the unit) to calculate the concentration of the original patient sample.</td>
</tr>
<tr>
<td>N/A</td>
<td>No parvovirus B19 specific DNA detected. Sample does not contain detectable amounts of parvovirus B19 specific DNA.</td>
</tr>
</tbody>
</table>
11. Disposal

Dispose of hazardous and biological waste in compliance with local and national regulations. Leftover product components and waste should not be allowed to enter sewage, water courses or the soil.

CAUTION

Always treat samples as infectious and (bio-)hazardous in accordance with safe laboratory procedures. For sample material spills promptly use an appropriate disinfectant. Handle contaminated materials as biohazardous.

CAUTION

Dispose of hazardous and biological waste only in compliance with local and national regulations to avoid environmental contamination.

NOTE

Liquid waste and any liquids containing Lysis Buffer or Wash Buffer 1 contain guanidine thiocyanate, which can form toxic, highly reactive and volatile compounds when combined with bleach or strong acids.

NOTE

The PCR Plate must be disposed of in sealed state, since the AltoStar® PCR Plate Sealing Foil cannot be removed.
12. Performance Evaluation

The performance evaluation of the AltoStar® Parvovirus B19 PCR Kit 1.5 was performed using the 3rd WHO International Standard for Parvovirus B19 for Nucleic Acid Amplification Techniques (NIBSC code: 12/208) and parvovirus B19 standard material calibrated against the WHO International Standard.

12.1 Plasma

12.1.1 Analytical Sensitivity

For the determination of the limit of detection (LoD) a dilution series of the 3rd WHO International Standard for parvovirus B19 for Nucleic Acid Amplification Techniques (NIBSC code: 12/208) in plasma ranging from 1,000 - 1 IU/ml was generated.

Each dilution was tested in 8 replicates on 3 different days (total n = 24 per dilution) using combinations of 3 AltoStar® Parvovirus B19 PCR Kit 1.5 lots, 3 AltoStar® Purification Kit 1.5 lots and 3 AltoStar® Internal Control 1.5 lots. Runs were performed using 3 different AltoStar® Automation System AM16 and CFX96™ DW Dx.

Data from all runs were combined and a probit analysis was performed to determine the 95 % LoD value.
Table 13: PCR results used for the calculation of the analytical sensitivity of the AltoStar® Parvovirus B19 PCR Kit 1.5

<table>
<thead>
<tr>
<th>Concentration [IU/ml]</th>
<th>N [total]</th>
<th>N [positive]</th>
<th>Hit rate [%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,000</td>
<td>24</td>
<td>24</td>
<td>100</td>
</tr>
<tr>
<td>500</td>
<td>24</td>
<td>24</td>
<td>100</td>
</tr>
<tr>
<td>250</td>
<td>24</td>
<td>24</td>
<td>100</td>
</tr>
<tr>
<td>200</td>
<td>24</td>
<td>24</td>
<td>100</td>
</tr>
<tr>
<td>150</td>
<td>24</td>
<td>24</td>
<td>100</td>
</tr>
<tr>
<td>100</td>
<td>24</td>
<td>23</td>
<td>95.8</td>
</tr>
<tr>
<td>50</td>
<td>24</td>
<td>19</td>
<td>79.2</td>
</tr>
<tr>
<td>20</td>
<td>24</td>
<td>12</td>
<td>50</td>
</tr>
<tr>
<td>10</td>
<td>24</td>
<td>7</td>
<td>29.2</td>
</tr>
<tr>
<td>5</td>
<td>24</td>
<td>7</td>
<td>29.2</td>
</tr>
<tr>
<td>1</td>
<td>24</td>
<td>2</td>
<td>8.3</td>
</tr>
</tbody>
</table>

The limit of detection of the AltoStar® Parvovirus B19 PCR Kit 1.5 for the detection of parvovirus B19 in plasma is 121 IU/ml (95 % confidence interval: 79 - 218 IU/ml).

12.1.2 Analytical Specificity

The analytical specificity of the AltoStar® Parvovirus B19 PCR Kit 1.5 is ensured by the thorough selection of the oligonucleotides (primers and probes). The oligonucleotides were checked by sequence comparison analysis against publicly available sequences to ensure that all relevant parvovirus B19 genotypes will be detected.

For the verification of the analytical specificity of the AltoStar® Parvovirus B19 PCR Kit 1.5 the following experiments were performed (see chapters 12.1.2.1 Negative Samples to 12.1.2.3 Cross Reactivity):
12.1.2.1 Negative Samples
69 parvovirus B19 negative plasma samples from individual donors were tested with the AltoStar® Parvovirus B19 PCR Kit 1.5. 66 out of 69 samples were tested negative for parvovirus B19 specific DNA whereas all samples were tested positive for the Internal Control. The analytical specificity of the AltoStar® Parvovirus B19 PCR Kit 1.5 for plasma samples is ≥ 95 %.

12.1.2.2 Interfering Substances
To evaluate the influence of potentially interfering endogenous and exogenous substances on the performance of the AltoStar® Parvovirus B19 PCR Kit 1.5 selected substances were spiked in plasma samples containing parvovirus B19 in a concentration of the 3 x LoD (363 IU/ml), of 10,000 IU/ml and no parvovirus B19, respectively.

Results obtained for samples containing potentially interfering substances were compared to results generated for plasma samples containing no spiked interferent. Each sample was processed in 3 replicates. No interference was observed for samples containing elevated levels of endogenous (bilirubin, hemoglobin, triglycerides, human serum albumin and human genomic DNA) or exogenous (Diclofenac, Ibuprofen, Azathioprine and Cyclosporine) substances.

CAUTION
The presence of PCR inhibitors (e.g. heparin) may cause false negative or invalid results.

12.1.2.3 Cross Reactivity
The analytical specificity of the AltoStar® Parvovirus B19 PCR Kit 1.5 with respect to cross reactivity with other pathogens than parvovirus B19 was evaluated by testing viruses related to parvovirus B19, viruses causing similar symptoms as an infection with parvovirus B19 and viruses likely to be present in patients suffering from a parvovirus B19 infection.
The AltoStar® Parvovirus B19 PCR Kit 1.5 did not cross react with any of the following pathogens:

- Herpes simplex virus-1 (HSV-1)
- Herpes simplex virus-2 (HSV-2)
- Varicella-Zoster virus (VZV)
- Epstein-Barr virus (EBV)
- Human herpesvirus 6A (HHV-6A)
- Human herpesvirus 6B (HHV-6B)
- Adenovirus (ADV) subtype 14
- Cytomegalovirus (CMV)
- BK virus (BKV)
- JC virus (JCV)
- Hepatitis A virus (HAV)
- Hepatitis B virus (HBV)
- Hepatitis C virus (HCV)
- Human immunodeficiency virus 1 (HIV-1)

**CAUTION**

In case the sample contains other pathogens than parvovirus B19 competition with the target amplification or cross-reactivities may occur.

### 12.1.3 Linear Range

For the determination of the linear range of the AltoStar® Parvovirus B19 PCR Kit 1.5 a dilution series of parvovirus B19 in plasma ranging from 200,000,000 - 100,000,000 IU/ml was tested. Dilutions with a concentration between 100,000,000 and 1,000,000 IU/ml were tested in 4 replicates, dilutions with a concentration between 100,000 and 200 IU/ml were tested in 8 replicates. Analysis was performed based on a polynomial regression.

The linear range of the AltoStar® Parvovirus B19 PCR Kit 1.5 for the quantification of parvovirus B19 in plasma is 500 - 100,000,000 IU/ml. A graphical representation of the data is shown in the Figure 49.
LOG10 Estimated Concentration vs. LOG10 Nominal Concentration
AltoStar® Parvovirus B19 PCR Kit 1.5

Figure 49: Linear regression analysis of the AltoStar® Parvovirus B19 PCR Kit 1.5 with plasma samples

12.1.4 Precision

Precision of the AltoStar® Parvovirus B19 PCR Kit 1.5 was evaluated using a panel consisting of a parvovirus B19 high positive (10,000 IU/ml), a parvovirus B19 low positive (2,500 IU/ml (5 x lower limit of quantitation (LLoQ))) and a parvovirus B19 negative plasma sample. 5 runs were performed with different combinations of 3 AltoStar® Parvovirus B19 PCR Kit 1.5 lots, 3 AltoStar® Purification Kit 1.5 lots and 3 AltoStar® Internal Control 1.5 lots. Runs were performed on 5 different days using 3 different AltoStar® Automation System AM16 and 3 CFX96™ DW Dx. Each panel member was tested in at least 4 replicates per run.

Repeatability (intra-run variability), inter-lot variability and reproducibility (total variability) were determined based on quantification values for the parvovirus B19 high and low positive samples (see Table 14) and on threshold cycle (C_q) values for the Internal Control in the parvovirus B19 negative samples (see Table 15).
Table 14: Precision data (CV % log10 quantification data) for parvovirus B19 high and low positive plasma samples

<table>
<thead>
<tr>
<th></th>
<th>Parvovirus B19 High Positive Sample (10,000 IU/ml)</th>
<th>Parvovirus B19 Low Positive Sample (2,500 IU/ml)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intra-Run Variability</td>
<td>0.36 - 1.59</td>
<td>0.98 - 3.66</td>
</tr>
<tr>
<td>Inter-Lot Variability</td>
<td>2.20</td>
<td>4.46</td>
</tr>
<tr>
<td>Total Variability</td>
<td>2.35</td>
<td>3.59</td>
</tr>
</tbody>
</table>

Table 15: Precision data (CV % Cq values) for the Internal Control in parvovirus B19 negative plasma samples

<table>
<thead>
<tr>
<th></th>
<th>Internal Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intra-Run Variability</td>
<td>0.14 - 0.46</td>
</tr>
<tr>
<td>Inter-Lot Variability</td>
<td>0.44</td>
</tr>
<tr>
<td>Total Variability</td>
<td>0.38</td>
</tr>
</tbody>
</table>

12.1.5 Total Failure Rate

The robustness of the AltoStar® Parvovirus B19 PCR Kit 1.5 was assessed by testing 30 parvovirus B19 negative plasma samples from individual donors spiked with parvovirus B19 to a final concentration of the 3 x LoD (363 IU/ml). All (30 out of 30) samples were tested positive in the parvovirus B19 specific fluorescence detection channel (FAM™).

12.1.6 Carry Over

Carry over is mostly a workflow dependent risk and independent of the PCR assay used. For the AltoStar® workflow potential cross contamination through carry over from high positive samples was evaluated by testing alternating parvovirus B19 high positive (1.00E+07 IU/ml) and negative samples (n = 44 each per run; 2 runs) with the AltoStar® Parvovirus B19 PCR Kit 1.5. No carry over was observed (i.e. all parvovirus B19 negative samples were tested negative).
12.1.7 Diagnostic Evaluation

The AltoStar® Parvovirus B19 PCR Kit 1.5 was evaluated in a comparative study with the CE-marked RealStar® Parvovirus B19 PCR Kit 1.0. Retrospectively 126 plasma samples from routine parvovirus B19 monitoring were tested in parallel using the RealStar® Parvovirus B19 PCR Kit 1.0 in combination with the VERSANT® kPCR Molecular System SP/AD modules (Siemens) and using the AltoStar® Parvovirus B19 PCR Kit 1.5 in combination with the AltoStar® Purification Kit 1.5 and the AltoStar® Internal Control 1.5 on the AltoStar® Automation System AM16 and the CFX96™ DW Dx. For the qualitative analysis all samples with an invalid result for one or both assays as well as samples with a quantitative result below the limit of detection of one or both assays were excluded. Results for the remaining 109 samples are shown in Table 16.

Table 16: Results of the evaluation of the diagnostic sensitivity and specificity for plasma samples

<table>
<thead>
<tr>
<th>RealStar® Parvovirus B19 PCR Kit 1.0</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>POSITIVE</td>
<td>NEGATIVE</td>
</tr>
<tr>
<td>AltoStar® Parvovirus B19 PCR Kit 1.5</td>
<td></td>
</tr>
<tr>
<td>POSITIVE</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td>0</td>
</tr>
<tr>
<td>NEGATIVE</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>20</td>
</tr>
</tbody>
</table>

The diagnostic sensitivity as well as the specificity of the AltoStar® Parvovirus B19 PCR Kit 1.5 compared to the RealStar® Parvovirus B19 PCR Kit 1.0 were 100 %, respectively.

For the quantitative correlation samples tested negative with one or both assays and samples with a quantitative result below the lower limit of quantitation of one or both assays were excluded. The results of the remaining 89 samples were used for the quantitative correlation by linear regression analysis (see Figure 50).
Figure 50: Linear regression analysis of the results obtained with the RealStar® Parvovirus B19 PCR Kit 1.0 (reference) and the AltoStar® Parvovirus B19 PCR Kit 1.5.

There was very good correlation between the quantitative results obtained with the AltoStar® Parvovirus B19 PCR Kit 1.5 and the RealStar® Parvovirus B19 PCR Kit 1.0 (correlation coefficient $R = 0.96$ ($R^2 = 0.93$)).
13. Quality Control

In accordance with the altona Diagnostics GmbH ISO EN 13485-certified Quality Management System, each lot of AltoStar® Parvovirus B19 PCR Kit 1.5 is tested against predetermined specifications to ensure consistent product quality.

14. Technical Assistance

For customer support, please contact the altona Diagnostics Technical Support:

   e-mail:  support@altona-diagnostics.com
   phone:  +49-(0)40-5480676-0

15. Literature


16. Trademarks and Disclaimers

AltoStar®, RealStar® (altona Diagnostics); CFX96™, CFX Manager™, Hard-Shell® (Bio-Rad); VERSANT® (Siemens); FAM™, VIC™ (Thermo Fisher Scientific).

Registered names, trademarks, etc. used in this document, even if not specifically marked as such, are not to be considered unprotected by law.

The AltoStar® Parvovirus B19 PCR Kit 1.5 is a CE-marked diagnostic kit according to the European in vitro diagnostic directive 98/79/EC.

Product not licensed with Health Canada and not FDA cleared or approved.

Not available in all countries.

© 2020 altona Diagnostics GmbH; all rights reserved.
17. Explanation of Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>IVD</td>
<td>In vitro diagnostic medical device</td>
</tr>
<tr>
<td>GTIN</td>
<td>Global Trade Item Number</td>
</tr>
<tr>
<td>LOT</td>
<td>Batch code</td>
</tr>
<tr>
<td>CONT</td>
<td>Content</td>
</tr>
<tr>
<td>CAP</td>
<td>Cap color</td>
</tr>
<tr>
<td>REF</td>
<td>Catalogue number</td>
</tr>
<tr>
<td>NUM</td>
<td>Number</td>
</tr>
<tr>
<td>COMP</td>
<td>Component</td>
</tr>
<tr>
<td>i</td>
<td>Consult instructions for use</td>
</tr>
<tr>
<td>v</td>
<td>Contains sufficient for &quot;n&quot; tests/reactions (rxns)</td>
</tr>
<tr>
<td>l</td>
<td>Temperature limit</td>
</tr>
<tr>
<td>g</td>
<td>Use-by date</td>
</tr>
<tr>
<td>a</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>!</td>
<td>Caution</td>
</tr>
<tr>
<td>MAT</td>
<td>Material number</td>
</tr>
<tr>
<td>i</td>
<td>Version</td>
</tr>
<tr>
<td>i</td>
<td>Note</td>
</tr>
</tbody>
</table>
always a drop ahead.